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Welcome!

Your EPSON Stylus® Photo 2200 is the ultimate desktop printer for professional and 
amateur photography. Your outstanding printouts result from these advanced 
features:

■ EPSON’s 7-color inks let you print up to 2880 × 1440 dpi (dots per inch). 

■ Large gamut, pigment-based, EPSON® UltraChrome™ inks and compatible, 
lightfast papers deliver long-lasting, water-resistant prints.

■ Four-picoliter variable ink droplets give you finer shadow detail, dazzling 
highlights, and better fill across a wider range of colors. 

■ Interchangeable Photo Black and optional Matte Black ink cartridges for 
precision ink coverage on any type of paper.

■ Large format capabilities let you print panoramics, portraits, and specialty prints 
up to 13 × 44 inches.

■ Straight-through, manual feed slot for thick paper (up to 0.05-inch) gives you 
more media choices than ever before.

■ Roll paper feeder and automatic roll paper cutter enable continuous printing and 
cutting of multiple photos.

■ Quickly create borderless, frame-ready prints in a variety of popular photo sizes 
(when using glossy, semigloss, or luster photo papers).
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PRINT Image Matching and Exif Print

Your EPSON Stylus Photo 2200 printer supports these innovative digital image 
formats to give you the best photo prints possible:

■ PRINT Image Matching™ (both P.I.M. and P.I.M. II)

■ Exif Print

About PRINT Image Matching

EPSON’s revolutionary PRINT Image Matching (P.I.M.) technology lets your digital 
camera and printer work together automatically to produce the best prints possible. 
Digital camera manufacturers that support PRINT Image Matching include EPSON, 
Casio,® Konica,® Kyocera,® Minolta,® Nikon,® Olympus,® Pentax,® Ricoh,® Sanyo,® 
Sony,® and Toshiba.® Check with your camera’s manufacturer or visit 
www.printimagematching.com to find out if PRINT Image Matching technology is 
included with your camera.

With PRINT Image Matching, the digital camera manufacturer can set specific 
printing options for each camera model. These options include:

■ contrast, sharpness, and brightness

■ gamma level, color space, color saturation, and noise reduction

■ shadow point, highlight point, and color balance

The camera saves this information in each JPEG or TIFF image file. Your printer—
along with EPSON Software™ Film Factory™ or the P.I.M. II Plug-in for Adobe® 
Photoshop® (included with your printer)—uses the information to ensure the most 
accurate image reproduction.

But don’t worry if your camera doesn’t include PRINT Image Matching 
technology—your EPSON Stylus Photo 2200 gives great photo printing results, just 
without the adjustments P.I.M.-enabled cameras may add.
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About Exif Print

The Exif (Exchangeable Image File) Print format includes information about your 
digital camera settings in JPEG/TIFF files so your printer and application can use 
them to create accurate print settings. Most digital cameras store Exif Print 
information such as shutter speed, metering, flash, and exposure settings, resolution, 
and lens use in the JPEG/TIFF image file. Your printer—along with EPSON 
Software Film Factory and the P.I.M. II Plug-in for Adobe Photoshop—uses the 
information to ensure the most accurate image reproduction.

About Your Software

Your printer CD-ROM includes all the software you need for printing. See the 
Start Here sheet for installation instructions.

■ Your printer driver runs your printer and lets you control how your documents 
look. You can’t print without it. 

Tip: It’s a good idea to check EPSON’s support web site periodically for free 
updates to your printer driver. Visit http://support.epson.com. Download 
instructions are posted for your convenience.

■ Your photo software includes these great tools:

EPSON Software Film Factory is a photo management program 
that lets you organize, beautify, and print your photos in a flash. 
Supports PRINT Image Matching, P.I.M. II, and Exif Print 
(except with Mac® OS X). 

P.I.M. II Plug-in for Adobe Photoshop lets you retain PRINT Image Matching, 
P.I.M. II, and Exif Print image quality when you import JPEG or TIFF files from 
your P.I.M.-enabled digital camera. (Compatible with Photoshop 6.0 and 7.0, 
and Photoshop Elements 1.0 and 2.0.)

■ Your EPSON Printer Information Center gives you quick, on-screen 
access to information about your printer. It includes EPSON Print 
Show animated tutorials on loading roll paper, replacing ink 
cartridges, and other tasks. It also includes an on-screen Reference 
Guide for additional information about your printer. (The desktop 
icon may be different on some Mac OS X systems.)
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■ EPSON PhotoCenter  is EPSON’s free photo-sharing web site 
where you can store, organize, and share your photos; print 
high-resolution photos straight from the web; and create free online 
postcards with your photos. Your printer software installer lets you add 
a link to EPSON PhotoCenter on your desktop.

■ Exclusive software offers, demos, and trial versions:

nik Color Efex Pro!™ provides the most award-winning collection of digital 
photographic filters available, including Polarization, Skylight, Graduated Blue, 
Soft Focus, and other filters. (Works only with full versions of Photoshop.)

nik Sharpener Pro!™ provides the most accurate and easiest method for 
sharpening images without oversharpening or creating halos.

Monaco Systems™ MonacoEZcolor™ lets you build ICC device profiles for 
accurate color between scanned, displayed, and printed images.

About Your Documentation

To set up your printer and install its software, see the Start Here sheet. 

This book contains system requirements, important safety information, your 
warranty, and instructions on:

■ Using the EPSON Printer Information Center

■ Loading all types of paper

■ Printing with Windows® or on a Macintosh®

■ Maintaining the printer

■ Solving basic problems

SM



Welcome! 5

Please follow these guidelines throughout:

Warnings must be followed carefully to avoid bodily injury.

Cautions must be observed to avoid damage to your equipment.

Notes contain important information about your printer.

Tips contain hints for better printing.

For more details about your printer, see your Print Show movies and Reference Guide, 
as described below. 

Using the EPSON Printer Information 
Center

Need help loading roll paper or installing the cutter? Use the EPSON Printer 
Information Center to view printer movies and a manual that quickly tell you how. 
Follow the instructions on the Start Here sheet to install the EPSON Printer 
Information Center, if you haven’t already.

Note: You need a browser—such as Microsoft® Internet Explorer 4.0 or later or 
Netscape® Navigator® 3.0 or later—to view the manual. If you are using a 
different browser, the pages may not display correctly. 

Launching the Movies

1. Double-click the EPSON 
Printer Information Center icon 
on your desktop. 

2. Click Print Show.

3. Click a movie title. 

Use the program tools to pause a 
movie, replay a step, or skip ahead.

4. Click Exit to exit EPSON Print 
Show.
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Launching the Manual

1. Double-click the EPSON Printer Information Center icon on your 
desktop. 

2. Click Reference Guide. You see this screen:

3. Click a topic on the left to expand the table of contents. 

4. Click on the topic you want to view.

■ Click right arrows  to view subtopics, then click on a topic.

■ Click down arrows to close a subtopic list.

Note: If you see an icon for a graphic when viewing your Reference Guide in 
Netscape Navigator, click the Reload button to load the graphic.

Click a topic 
to expand 
the table of 
contents

Closed list, 
click to 
expand

Click to go 
to topic
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Printer Buttons and Lights

The tables below summarize the functions of the printer buttons and lights. See the 
instructions in your documentation for details on using the buttons. To diagnose 
problems indicated by the printer lights, see page 70. 

Printer buttons

Printer buttons Uses

P power Turns the printer on and off. Hold down the button until the Power 
light comes on or goes off.

m paper Loads or ejects paper.

Resumes printing after a paper-out or multiple-sheet-feed error.

H ink Moves the print head to the ink cartridge replacement position and 
returns it to its home position.

Cleans the print head. Hold down the button for three seconds 
when all the red H Ink Out lights are off.

z roll paper Prints a cutting guideline and feeds roll paper to the removal 
position after roll paper printing.

Returns roll paper to the printing position after cutting.

When using the automatic roll paper cutter, cuts, feeds, and 
returns the paper to printing position automatically.

Reverses roll paper out of the printer. Hold down the button for 
three seconds.

Printer lights

Printer lights Meaning

P power On: printer is turned on.

Flashing: printer is receiving data, printing, in ink replacement 
mode, charging ink, or cleaning the print head.

m paper out On: printer is out of paper or multiple sheets have been fed.

Flashing: paper is jammed in the printer.

H ink (seven) On: the indicated ink cartridge is empty.

Flashing: the indicated ink cartridge is low on ink.

Lights flash in a pattern: the printer is performing an ink operation.
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Loading Paper

You can load a variety of paper types in your printer, as described in these sections:

■ “Loading Paper in the Sheet Feeder” below

■ “Loading Envelopes” on page 11

■ “Loading Roll Paper” on page 12

■ “Loading and Printing on Thick Paper” on page 17

Loading Paper in the Sheet Feeder

Follow these steps to load plain paper and many special papers in the sheet feeder:

1. Slide the left edge guide to the position for your paper size, as marked on the 
paper support.

2. Place your paper in the printer on 
the right side of the sheet feeder.

3. Adjust the left edge guide to fit 
lightly against the paper. 

4. Open the output tray extensions.

Also follow these loading guidelines:

■ Always load the short edge first, 
even for printing landscape-
oriented documents.

■ Load the printable side face up. It’s usually whiter or brighter than the other side.

■ Load letterhead or preprinted paper into the printer top edge first.

■ Don’t load paper above the arrow on the left edge guide.

Load paper against 
this side
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Loading Special Paper

Load EPSON ink jet papers as follows:

■ Load EPSON Velvet Fine Art Paper only in the manual feed slot, following the 
instructions on page 17.

■ Check the paper package for additional handling instructions.

■ Set the adjust lever on the side of the printer to the m position.

■ If ink smears on thicker paper, try printing with the lever set to the ^ position.

Paper type Loading capacity

EPSON Enhanced Matte Paper 20 sheets of letter-size paper with a 
support sheet beneath the stack;
10 sheets of A3- or Super B-size paper

EPSON Premium Semigloss Photo Paper 20 sheets of letter-size paper;
1 sheet of Super B-size paper

EPSON Watercolor Paper - Radiant White 1 sheet at a time

EPSON Premium Luster Photo Paper 20 sheets of letter-size paper;
1 sheet of A3- or Super B-size paper

EPSON Premium Glossy Photo Paper 1 sheet at a time

EPSON Velvet Fine Art Paper 1 sheet at a time; manual feed slot only

EPSON Premium Bright White Paper Up to 0.3-inch (8 mm) total thickness 
(about 30 sheets)
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Loading Envelopes

You can load up to 10 envelopes at a time, as described below.

Tip: For best results, press each envelope flat before loading it, or load one 
envelope at a time. You’ll get the best results printing on envelopes using the 
optional Matte Black ink cartridge.

1. Load envelopes as shown, with the flap side down and the flap edge against the 
right side of the sheet feeder. 

2. Slide the left edge guide against the envelopes.

3. Set the adjust lever to the ^ position.

4. Choose these settings in your printer 
software:

■ Plain Paper as the Type (Windows) or 
Media Type (Macintosh) setting

■ Black Ink Only (Windows) or Black as 
the Ink setting (Macintosh)

■ The envelope size as the Size (Windows) 
or Paper Size (Macintosh) setting

■ Landscape as the Orientation setting

See page 20 (Windows), page 25 (Macintosh OS 8.6 to 9.x), or page 27 
(Macintosh OS X) for instructions.

Load with the 
printable side up, 
flap edge right
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Loading Roll Paper

You can load roll paper in these sizes:

■ 4 inches wide 

■ 8.3 inches wide 

■ 13 inches wide 

Note: You can’t print on roll paper when you’re printing with Macintosh OS X 
applications.

1. Place the roll paper on the holders as 
shown, then remove the tape and 
protective paper from the end of the roll. 

2. Make sure the end of the paper is cut 
straight across, with 90° corners. If the 
end is cut diagonally, you may have 
problems feeding the paper.

3. If the paper curls at the end, roll it 
backwards between a folded sheet of 
paper to uncurl it. 

Avoid touching the printable surface of 
the roll paper.

4. Remove any paper that’s in the sheet 
feeder at the top of the printer. Then 
remove the paper support, lower the 
output tray, and turn on the printer.
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5. Set the adjust lever to the m position.

6. Install the roll paper holders on the printer. Insert the left holder into the far left 
slot, then insert the other holder into the corresponding slot on the right.

7. Load the paper part of the way into the 
roll paper feeder, then slide the right roll 
paper edge guide to fit lightly against 
the paper.

Don’t load roll paper in the cut 
sheet feeder

Roll paper feeder

Caution: Don’t load roll paper into the 
sheet feeder at the top of the printer.
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8. Push the paper into the feeder as far as it 
will go; the printer feeds the paper 
automatically.

9. To verify that the paper is loaded 
straight, open the printer cover and look 
into the printer. 

If the paper is crooked, press the z roll 
paper button for three seconds to back 
the paper all the way out. 

Then turn the roll paper holder knobs to 
roll up the paper. Press the z roll paper 
button to clear the paper out error. 
Repeat steps 7 through 9 to reload the 
paper.

If you want to use the cutter, follow the steps on page 15 to install it.

If not, follow the instructions on page 31 to print on roll paper.

If crooked, press 
z button for three seconds
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Installing the Roll Paper Cutter and Basket

1. Turn off the printer.

2. Press the lever on the left side of the 
output tray, then gently guide the tray 
off its mounting tabs, left side first.

3. Insert the cutter into the top of the 
opening as shown, and press it in 
evenly on both sides, until it clicks 
into place.

4. Position the basket as shown, and 
slide it onto the guide rails on the 
bottom of the cutter.

5. If the cloth on the basket isn’t attached at both ends, lift the free edge of the cloth 
over the basket frame and attach the loops to the hooks on the frame.

Lever

Caution: Don’t install the 
basket if you’re printing photos 
longer than 11.7 inches; this 
may cause a paper jam. The 
basket holds 40 photos, up to 
7 inches long. For longer 
photos, remove each one after 
it’s printed.
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6. Push down the cloth in the middle to form a basket to hold your cut photos.

7. Turn the printer back on.

8. Now adjust the cutting position as described below.

Adjusting the Cutting Position

Before you print your photos on roll paper using the automatic roll paper cutter, you 
need to adjust the cutting position. This adjustment affects roll paper only.

1. Access the printer settings window (see page 20 for Windows or page 25 for 
Macintosh OS 8.6 to 9.x).

2. Click the Maintenance tab (Windows) or the utility icon (Macintosh). 

3. Click the Printer and Option Information 
icon. You see a window like this (the Macintosh 
window looks different):

4. Click the Auto Cutter Adjustment button. 
You see an adjustment screen.

5. Click Print. The printer prints and cuts a 
cutting position pattern like this:

6. Place the two cut pieces together and 
examine the patterns. Identify the one 
with the most precise cut between the 
orange and black boxes. Then select 
that pattern number in the window 
shown here and click Finish.

7. Follow the instructions on page 31 to 
print and cut your photos.

If you notice any ink smears on your cut paper, clean the cutter as described on 
page 64.
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Loading and Printing on Thick Paper

You can load thick paper, such as EPSON Velvet Fine Art Paper, in the manual feed 
slot. Make sure your paper is white, up to 0.05-inch (1.3 mm) thick, and is flat and 
smooth, with no folded edges.

Note: You can’t print on thick paper in the manual feed slot when you’re printing 
with Macintosh OS X applications.

1. Turn off the printer and remove the roll 
paper holder and automatic roll paper cutter, 
if they’re installed (see page 36).

Note: You must remove the automatic roll 
paper cutter or manual feed slot printing won’t 
work.

2. Remove any paper loaded in the sheet 
feeder.

3. Turn on the printer. (The printer must be 
on to load thick paper correctly.)

4. Set the adjust lever to the ! position. 
The m paper light begins flashing 
rapidly.

5. Place one sheet of thick paper—printable 
side up—in the manual feed slot. Slowly 
insert it into the slot against the far left side.

6. Open the printer cover and look down into 
the printer as you slide the paper into the 
manual feed slot. 

Position the leading edge so it’s just past the 
small gray rollers, about 0.4-inch (1 cm). 

Make sure the paper is feeding straight; if 
not, tilt the paper slightly to the left or right 
to straighten it.

0.4-inch 
(1 cm)
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7. Set the adjust lever to the ^ position.

8. Before printing, select Manual as the Source 
setting (Windows) or Manual Feed as the 
Paper Source setting (Macintosh) in your 
printer software (see page 20 for Windows 
or page 25 for Macintosh).

9. When you’re finished printing on thick paper, return the adjust lever to 
the m position.

Caution: Don’t move the adjust lever during printing; this could damage your 
printer.

Note: If the m paper light flashes, make sure 
the adjust lever is set to the ^ position, then 
press the m paper button again.
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Printing From Start to Finish

Follow the steps in these sections to print using all your printer’s special features:

■ “Basic Printing in Windows” on page 20

■ “Basic Printing With Macintosh OS X” on page 22

■ “Basic Printing With Macintosh OS 8.6 to 9.x” on page 25

■ “Customizing Your Windows Print Settings” on page 27

■ “Customizing Macintosh Print Settings” on page 29

■ “Selecting the Correct Media Type” on page 31

■ “Printing on Roll Paper” on page 31

■ “Using PRINT Image Matching” on page 38

■ “Printing Borderless Cut Sheets” on page 47

■ “Managing Color with Custom Profiles” on page 49

Tip: Whenever you print, make sure you:

■ Use the right paper.

For the best-looking photos, most vivid colors, and greatest detail, always use 
genuine EPSON papers and EPSON UltraChrome inks. 

■ Choose the right printer settings for the paper.
Your printer automatically adjusts itself for the type of paper you’ve selected, 
so make sure your printer settings are correct for the paper you loaded. 
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Basic Printing in Windows

After you create a document in a software program, follow these steps to print it using 
the basic printer settings: 

1. From the File menu, click Print. You see a Print window like this one:

2. Make sure EPSON Stylus Photo 2200 is selected.

3. Click the Properties or Preferences button. (If you see a Setup, Printer, or 
Options button, click it. Then click Properties or Preferences on the next 
screen.)

Click here to open 
your printer 
software

Check for your printer name here
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4. Select the following settings on the Main tab in your printer settings window:

Note: For more information about printer settings, click the ? or Help button.

5. Click OK. You return to the Print window. 

6. Click OK or Print to start printing.

During printing, this window appears. Use it to cancel, pause, or resume printing and 
see how much ink you have left.

3 Select your 
paper type (see 
page 31)

6 Click OK

Draft: For rough drafts with 
reduced print quality

Text: For text-only 
documents (like letters) with 
good print quality

Text & Image: For 
documents with text and 
images with higher print 
quality

Photo: For photos and 
graphics with good print 
quality and speed

Best Photo: For photos or 
graphics with high print 
quality

4 Select your 
paper size

5 Select your 
document or 
image 
orientation

1 Select the type of document you’re printing:

2 Select your 
paper source

Click to cancel printing

Click to pause or 
resume printing
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Selecting the Settings You Use Most Often

Your printer settings apply only to the program you’re currently using. If you want, 
you can change the Windows default printer settings for all your programs.

1. Right-click the  printer icon in the lower right corner of your screen. 

2. Select Printer Settings. You see the window shown on page 21.

3. Select the default settings you want for all your applications, then click OK.

You can still change the printer settings in your program, if necessary.

Basic Printing With Macintosh OS X

If you’re using an OS X compatible printing application, follow the steps below to 
print a document. (If you’re using an application that’s compatible only with 
Macintosh Classic mode, follow the steps on page 25 instead.)

Before you begin, make sure you added your printer to Print Center, as described on 
the Start Here sheet.

1. From the File menu, select Page Setup.

2. Select the following Page Setup settings:

3. When you’re finished, click OK.

Select your 
printer from 
the Format for 
pop-up menu

Select the Paper Size, 
Orientation, and any 
other settings you 
want to use
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4. Select Print from the File menu. You see a screen like this:

5. Select Print Settings from the pull-down menu. 

6. Select the following Print Settings:

Note: For more information about printer settings, click Help. The OS X printer 
driver contains a subset of the settings available with the OS 8.6 to 9.x Macintosh 
printer driver described in this book.

Click here and 
select Print 
Settings 

4 Select Quality or Speed 
(for faster printing)

1 Select your paper type 
(see page 31)

3 Select Automatic mode

2 Select Color (for color 
documents and black 
and white photographs) 
or Black for black text 
documents
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7. You can also choose other print settings by selecting these options in the 
pull-down menu:

■ Copies & Pages, to select the number of copies or a page range

■ Layout, to select page layout options

■ Output Options, to save your print job as a PDF file

■ Color Management, to select ColorSync,® adjust the color controls, change 
the gamma setting, or turn off color adjustments by the printer software

■ Ink Configuration, to change the ink density and drying time

■ Summary, to view a list of all your selections

■ Save Custom Setting, to save your selections for future use. (Not available 
with Mac OS X 10.2.x.)

8. Click Print.

9. To monitor the progress of your print job, click the Print Center icon when it 
appears in the dock. On OS X 10.2.x, double-click SP 2200. You see this screen:

10. Monitor the progress of your print job or do one of the following:

■ Click the print job, then click Delete to delete the job

■ Click the print job, then click Hold to pause printing

■ Click a print job marked “Hold” and click Resume to resume printing

■ If multiple print jobs are listed, click a print job, then click the Priority arrow 
as necessary to reorder the jobs

11. When you’re finished, close Print Center.
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Basic Printing With Macintosh OS 8.6 to 9.x

Before you begin, make sure you selected your printer in the Chooser as described on 
the Start Here sheet.

1. From the File menu, select Page Setup. Select the following settings:

2. Click OK to close the Page Setup window. 

3. From the File menu, select Print. Select the following settings:

Note: For more information about printer settings, click the ? button.

1 Make sure you see SP 2200

2 Select your paper size

4 Select the orientation of your 
document or image

3 Select your paper source

4 Select Quality or Speed 
(for faster printing)

1 Select your paper type 
(see page 31)

3 Select Automatic mode

2 Select Color (for color 
documents and black 
and white photographs) 
or Black (for black text 
documents)
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4. You can also do the following:

■ Click  to reduce or enlarge your printed image, print multiple layouts, or 
add a watermark.

■ Click  to control background printing.

■ Click , then click Preview to preview your printout.

■ Click  to check your ink levels. 

5. Click Print. 

6. If you turned on background printing, select EPSON Monitor3 from the 
Application menu in the upper right corner of the screen. You see this window:

Note: If you’re not using background printing and you need to cancel printing, 
hold down the J key and press the . (period) key.

Select your print job, 
then click here to 
cancel printing

Click to check 
ink levels
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Customizing Your Windows Print Settings

1. On the Main tab, click the Advanced button in the bottom right corner of the 
window. Click Continue on the next screen. The Basic settings change to the 
Advanced settings.

2. Select the following advanced settings as necessary: 

3. Once you’ve finished selecting advanced settings, you can:

■ Click OK to save your settings, return to the Print dialog box, and print.

■ Click the Basic button to return to the Basic settings.

■ Click the Page Layout tab and continue with step 4 to select layout options.

Note: To manage color when you’re using Photoshop, see “Managing Color with 
Custom Profiles” on page 49.

For more information on advanced settings, or instructions on saving them as a 
group so you can reuse them later, click the Help or ? button. If you want to use 
the Advanced screen each time you access your printer settings, select the 
Show this screen first checkbox.

Select Paper & Quality 
Options as necessary

Click here to select a 
different print quality for 
your paper type

Select Print Options as 
necessary

Select a Color Management 
method 

To choose No Color 
Adjustment, click ICM first
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4. Select the following page layout settings as necessary:

Note: For more information on page layout settings, click the Help or ? button.

5. Click OK to save your settings, return to the Print dialog box, and print.

Select image or 
document position 
options here

Select image or 
document resizing 
options here; these 
affect only your 
printed image

Add a watermark to 
your printed page 
here

Select multi-page 
document options 
here and here

To print a large 
image on several 
sheets to make a 
poster, select 
settings here



Printing From Start to Finish 29

Customizing Macintosh Print Settings

1. On the printer settings window, click Custom, then click the Custom Settings 
list to open it.

Note: For more information on custom settings, click Help (OS X) or ? (OS 8.6 
to 9.x)

2. If you’re finished selecting custom settings, click Print to print your document.

To select more custom settings, go to step 3.

3. To access advanced settings, click Custom, then click Advanced Settings 
(OS X) or Advanced (OS 8.6 to 9.x).

Macintosh OS 8.6 

to 9.x

Macintosh OS X

Click Custom, then choose:

Economy (to save ink on plain paper) or 
ColorSync (to match printed colors with 
compatible device colors) from the Custom 
Settings list

Click Custom, then choose ColorSync from 
the Custom Settings list to match printed 
colors with compatible device colors 
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4. Select these advanced settings as necessary:

Note: For more information on advanced settings, or instructions on saving them 
as a group so you can reuse them later, click Help (OS X) or ? (OS 8.6 to 9.x).

5. OS X: Click Print.

OS 8.6 to 9.x: Click OK to save your settings, then click Print.

Macintosh OS 8.6 to 9.x

Select color management 
settings here

Click here to select a different 
print quality for your paper 
type

Select various print 
options here

Macintosh OS X

Select various print options here

To select color management 
settings, select Color 
Management from the Print 
Settings pull-down menu

Click here to select a 
different print quality for your 
paper type
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Selecting the Correct Media Type

Select the correct Type or Media Type setting so your printer knows what kind of 
paper you’re using and adjusts the ink coverage accordingly.

Printing on Roll Paper

Before you print on roll paper, do the following:

1. Load roll paper as described on page 12.

2. If you want to cut your photos automatically, install the automatic roll paper 
cutter and basket as described on page 15.

3. If you installed the cutter, adjust the cutting position as described on page 16.

Then follow the steps in the next sections to select your roll paper settings, control 
printing, and remove and store roll paper.

Note: You can’t print on roll paper when you’re printing with Macintosh OS X 
applications.

For this paper . . .

Select this Type or Media Type 

setting . . .

Plain paper sheets and envelopes Plain Paper

EPSON Premium Bright White Paper

EPSON Enhanced Matte Paper Enhanced Matte Paper

EPSON Premium Semigloss Photo Paper Premium Semigloss Photo Paper

EPSON Watercolor Paper - Radiant White Watercolor Paper - Radiant White

EPSON Premium Luster Photo Paper Premium Luster Photo Paper

EPSON Premium Glossy Photo Paper Premium Glossy Photo Paper

EPSON Velvet Fine Art Paper Velvet Fine Art Paper
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Selecting Roll Paper Print Settings

Windows

1. Start your print application, open your photo file, and resize it as necessary.

2. Access the printer settings window (see page 20). 

3. Select the type of roll paper you loaded as the Type option:

■ Premium Semigloss Photo Paper

■ Premium Luster Photo Paper 

■ Premium Glossy Photo Paper

4. If you’ll be printing photos without a border, click the Borderless box.
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5. Choose Roll as the Source setting. The Roll Paper Options dialog box pops up:

6. Select the roll paper settings based on the type of printing you’re doing, then 
click OK:

Note: If you’re using Film Factory with roll paper, select Roll Paper or Roll Paper 
(No Margins) as the Paper setting. To select cutting and other roll paper options, 
click Properties. Don’t change any other printer settings.

7. Select the photo size as the Size setting.

Type of printing

Borderless 

checkbox Auto Cutter setting Roll Paper Options

Print and cut 
borderless photos

Checked Normal Cut 
(don’t select 
Paper-Saving Cut; you 
may see a small margin 
or images may overlap)

Cut Sheet Mode 
(don’t select Banner 
Mode)

Print borderless 
photos and cut 
them yourself

Checked Manual Cut Cut Sheet Mode or 
Banner Mode

Print photos, 
panoramics, or 
banners with 
borders

Unchecked Manual Cut or 
Paper-Saving Cut (may 
leave a small margin)

Banner Mode
(if you selected 
Manual Cut, check 
Save Roll Paper to 
save paper at the 
end of your print job)
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Note: Don’t select any of these settings when printing on roll paper: 
PhotoEnhance, Reverse Order, Rotate 180°, Centered or Minimize Margins, or 
Sheet or Manual (for Source).

8. Click OK.

9. Click OK or Print.

10. Follow the steps on page 36 to remove your printed photos.

Macintosh

1. Start your print application, open your photo file, and resize it as necessary.

2. Click File > Page Setup.

3. Choose Roll Paper as the Paper Source setting.

4. Select the photo size as the Paper Size setting.

5. Select the rest of the settings based on the type of printing you’re doing:

Type of printing

Borderless 

checkbox Auto Cutter setting Roll Paper Options

Print and cut 
borderless photos

Checked Normal Cut 
(don’t select 
Paper-Saving Cut; you 
may see a small margin 
or images may overlap)

Cut Sheet (don’t 
select Banner)
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Note: If you’re using Film Factory with roll paper, select Roll Paper or Roll Paper 
(No Margins) as the Paper setting. To select cutting and other roll paper options, 
click Properties. Don’t change any other printer settings.

6. Click OK to close the Page Setup dialog box.

7. Click File > Print to open the printer settings dialog box.

8. Select the type of roll paper you loaded as the Media Type option:

■ Premium Semigloss Photo Paper

■ Premium Luster Photo Paper 

■ Premium Glossy Photo Paper

9. Click Print.

10. Follow the steps on page 36 to remove your printed photos.

Print borderless 
photos and cut 
them yourself

Checked Manual Cut Cut Sheet or 
Banner

Print photos, 
panoramics, or 
banners with 
borders

Unchecked Manual Cut or 
Paper-Saving Cut (may 
leave a small margin)

Banner 
(if you selected 
Manual Cut, check 
Save Roll Paper to 
save paper at the 
end of your print job)

Type of printing

Borderless 

checkbox Auto Cutter setting Roll Paper Options
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Removing Your Printed Photos

1. If you’re using the roll paper cutter, wait for printing and cutting to finish.

Caution: Remove each sheet of EPSON Premium Semigloss Photo Paper as it 
falls into the basket so it doesn’t get smeared by the next sheet.

2. Press the z roll paper button once to feed 
the paper forward. If you’re using the 
cutter, the last photo is cut off.

3. If you’re not using the cutter, cut the paper 
on the printed cutting line.

4. If you want to print another job on roll 
paper, press the z roll paper button once 
again; the paper returns to the correct print 
position.

5. Follow the steps in the next section if you’re 
finished printing on roll paper.

Removing and Storing Roll Paper

1. Press the z roll paper button for three seconds. The paper feeds backwards out of 
the printer. (If it doesn’t feed all the way out, repeat this step.)

2. Turn the knobs to roll the rest of the paper onto the holder. Then press the z roll 
paper button to turn off the m paper light.
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3. To remove the basket and automatic roll paper cutter, first turn off the printer. 
Pull the basket off the cutter, then press the gray buttons on top of the cutter and 
pull it off the printer.

4. If you removed the output tray, replace it on its right mounting tab, then press in 
the lever and insert the left side of the tray. Release the lever into the left 
mounting hole.

5. Pull the roll paper holder out of its mounting slots and remove the roll paper from 
the holder.

Return the unused roll to its original package. Store your printouts in resealable 
plastic bags, photo albums, or glass-covered picture frames. Keep both printed and 
unused roll paper away from high temperatures, humidity, and direct sunlight.
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Using PRINT Image Matching

With PRINT Image Matching, special print instructions are saved in your digital 
photo files. For example, macro mode pictures might include print commands for 
sharpness and clarity, while portrait mode pictures might emphasize soft focusing and 
subtle flesh tones. If your digital camera supports PRINT Image Matching (P.I.M. or 
P.I.M II), you can use this technology when you print with one of the following:

■ Film Factory, as described below

■ P.I.M. II Plug-in for Adobe Photoshop, as described on page 42

Using Film Factory

If your digital camera supports PRINT Image Matching, P.I.M. II, or Exif Print, you 
can use these technologies when you print with Film Factory to ensure the most 
accurate image reproduction (except with Mac OS X). Printing with P.I.M. isn’t 
complicated, and it provides the color corrections right from your P.I.M. image file, 
so you don’t have to correct them yourself. Just leave the PRINT Image Matching 
box checked.

You can also use Film Factory to organize, retouch, and print non-P.I.M. and 
non-Exif Print digital images.
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Opening Your Photos in Film Factory

1. Start Film Factory. You see the main Film Factory screen:

2. Select a “roll of film,” or click the Roll button and select New Roll. 

If your photos were taken with a digital camera that supports PRINT Image 
Matching, the (P.I.M.) logo appears in your photo thumbnails. Right-click 
(Windows) or Ctrl-click (Macintosh) a photo thumbnail to display information 
about the P.I.M. and/or Exif Print data in the photo file. (If you retouched a 
PRINT Image Matching photo, the P.I.M logo may not appear.)

3. Click the photo you want to print, or click the All button to select all the photos 
in a roll. Then go to step 5.

4. To import a photo into Film Factory, click the Import button, then:

■ Click From File to import a photo from your computer’s hard drive.

■ Click From Removable Media to import a photo from a disk or CD-ROM.

■ Click From PC Card to import a photo from a PC card in a card reader.

■ Click From TWAIN Device to import a photo from a scanner or digital 
camera. If your device is already selected, the software opens. If not, click 
Import Settings, and select your scanner or digital camera. (Not applicable 
to OS X.)

Click Roll to create 
a new roll, or . . .
click an existing roll

PRINT Image 
Matching photos 
are marked here
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5. Click a button on the left to select a print option. For 
example, click the Standard Prints button. You see buttons 
for each step you need to follow, as shown.

6. Click Import & Retouch to retouch or edit your photo, if 
necessary.

Note: You can rotate, trim, and correct for red eyes and still 
retain P.I.M., P.I.M. II, or Exif Print image quality with your 
photo. However, if you adjust other settings, such as brightness 
and color, your P.I.M. or Exif Print image quality will be lost.

To ensure you keep P.I.M. or Exif Print image quality in your 
original photo file, make a copy of the photo before you edit. 
Then make edits only to your copy.

7. When you’re ready to print, continue with the steps in the next section.

Note: If you need help with Film Factory, see the on-screen Getting Started 
Guide in the Film Factory folder on your hard drive.

Printing Your Photos

1. When you’re ready to print, click the Print Assignment button. You see this 
screen:

Click to print the 
date with your 
photo

Select your 
printer settings 
here
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2. Windows and Macintosh OS 8.6 to 9.x: Select these options in the Printer 
Settings box at the bottom of the screen, in this order:

Macintosh OS X: Click the Properties button. Select your printer in the Format 
for menu, select the correct Paper Size setting, and click OK. (BorderFree™ 
printing is not available with Film Factory for OS X.)

3. If you want to print the current date with your photo, click the Print Date box.

Note: You don’t need to select an Orientation setting. If your photo is wider than 
it is long, Film Factory automatically rotates the image.

4. Click the Print button on the left side of the screen. You see more options:

5. If your photo doesn’t look right in the preview, click the Back button to change 
your settings. (Click the Detailed Preview button for a closer look.)

1 Make sure your
printer is selected

2  Select Sheet 
Feeder, Roll Paper, 
or Roll Paper (No 
Margins)

3 Select your 
paper size

4 Select your 
paper type

Select the number 
of copies you want 
to print

Leave these boxes 
checked for the 
best printed output 
using P.I.M. and/or 
Exif Print data, if 
available
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6. Select the number of copies you want to print.

7. Leave the PRINT Image Matching and/or Exif Print box checked for the best 
results when printing photos containing P.I.M and/or Exif Print data. (Not 
applicable to OS X.)

8. Click the Print button at the top of the screen.

■ Windows: Your pictures are printed.

■ Macintosh 8.6 to 9.x: You see the Print window; click Print. Your pictures 
are printed.

■ Macintosh OS X: You see the Print window. Select Print Settings from the 
Copies & Pages pull-down menu. Then select your Media Type and other 
print settings as necessary, and click Print.

Store your prints in resealable plastic bags, photo albums, or glass-covered picture 
frames. Keep your photos and unused paper away from high temperatures, humidity, 
and direct sunlight. Make sure you return unused paper to its original package.

Using the P.I.M. II Plug-in for Adobe Photoshop

The P.I.M. II Plug-in for Adobe Photoshop allows you to retain the P.I.M. or Exif 
Print image quality when you import JPEG or TIFF files from your P.I.M.- or Exif 
Print-enabled digital camera. The P.I.M. II Plug-in works with Photoshop 7.0 and 
6.0, and Photoshop Elements 1.0 and 2.0. You’ll also need to use the ICC profiles for 
your printer that are installed with the plug-in (Windows) or the printer driver 
(Macintosh).

Photoshop doesn’t retain the PRINT Image Matching or Exif Print information 
separately in the header file when you import your P.I.M. or Exif Print image. 
Instead, it converts that information in the file and embeds a color space called 
EPSON RGB 2001. This profile supports all the P.I.M. color advantages and 
enhancements. 
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You can crop, rotate, resize, work with layers, play with filters, and even make 
selective color adjustments to the P.I.M. image while retaining P.I.M. quality. 
However, you won’t benefit from global color adjustments (such as Auto Levels, Auto 
Contrast, Auto Color, etc.). Also, if you try to use your new Photoshop file in another 
P.I.M.-enabled software program, it won’t be recognized as a P.I.M. image. You need 
to keep your original file if you want to take advantage of P.I.M. information in other 
programs.

Importing a P.I.M. Image

Note: The illustrations in the sections below show Macintosh screens; Windows 
screens look different, but the settings are the same.

1. Before importing a P.I.M. image, change your color settings. Select Color 
Settings from the Edit menu, then select Full color management - optimized 
for Print and click OK.

2. Open the File menu and select Import > 
PRINT Image Matching II. You see a 
window like this:

3. Select the folder containing your P.I.M. 
or Exif Print images. (In Windows, all 
your JPEG and TIFF files are listed; on a 
Macintosh, only P.I.M. and Exif Print 
files appear.)

4. Select the image you want to import.

5. To see a preview of the P.I.M. II, Exif 
Print, or color extension effects for the 
selected image, check the Image 
Preview box. (In Windows, non-P.I.M. 
and non-Exif Print images won’t preview.)

6. Choose an import option:

■ PRINT Image Matching II enables the greatest range of image enhancements 
and effects. It also supports the EPSON RGB expanded color space, which is 
similar to the Adobe RGB color space and is required for PRINT Image 
Matching image quality prints. This setting is available only for P.I.M. and 
P.I.M. II images.
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■ Exif Print enables Exif 2.2 effects and allows for an expanded color space. 
This option does not use P.I.M. II settings. This setting is available only for 
files that contain Exif Print data.

■ Color extension only enables you to print using an expanded color space, 
but does not include P.I.M. II or Exif Print effects, such as brightness, 
sharpness, and other settings. This option is available only for P.I.M. II and 
Exif Print images.

7. Click the Open button. Your image opens and the import window remains on 
the screen.

8. Select and open more images or click Cancel to close the Open PRINT Image 
Matching II file window. (If you don’t want the window to remain on the screen 
after you open a file, uncheck Import consecutively.)

9. Follow the steps in the next section to print your image.

To keep the P.I.M. or Exif Print header information intact for use in other P.I.M.- or 
Exif Print-enabled programs, keep the original file; don’t use the Photoshop Save 
command. Instead use Save As to rename the file. It won’t contain P.I.M. header 
information, but will retain P.I.M. image quality, as long as the file is saved with the 
ICC profile embedded. 

Note: If you overwrite your original file, you will lose all P.I.M. or Exif Print header 
information.

Note: If you see this screen, 
select Use the embedded 
profile and click OK.
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Printing a P.I.M. Image

P.I.M. images are converted into the EPSON RGB 2001 color space. To retain 
P.I.M. quality and enhancements, don’t change the color space.

Note: The illustrations in the sections below show Macintosh screens; Windows 
screens will look different, but the settings are the same.

1. Open the File menu, then:

■ Photoshop 7.0 or Elements 1.0 or 2.0: Select Print Preview, Print Options, 
or Print with Preview. Then click Show More Options > Color 
Management.

■ Photoshop 6.0: Select Print.

You see one of the windows below:

2. In the Source Space box, make sure the EPSON RGB 2001 option is selected.

3. In the Print Space box, select the SP2200 profile for the paper you’re printing on. 
We recommend Perceptual as the Intent setting.

Note: Choose a profile labelled PK if you’re using the Photo Black ink cartridge. If 
you’re using the optional Matte Black cartridge, select a profile labelled MK.

Make sure this source is selected

Select the profile for your printer and paper

Photoshop 7.0/Elements Photoshop 6.0

Select your paper
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4. Photoshop 7.0 or Elements: Click Print. You see the printer settings window.

Photoshop 6.0: Go to step 5.

Note: In Windows, click Setup, then select your printer and click Properties or 
Preferences to select these settings.

5. Windows only: Select Photo or Best Photo.

6. Select the paper you’re printing on as the Type or Media Type setting.

7. Macintosh: Click Custom, then click the Advanced or Advanced Settings 
button. 

Windows: Click the Advanced button.

8. Macintosh 8.6 to 9.x: Select No Color Adjustment and click OK.

Macintosh OS X: Select Color Management from the Print Settings pull-down 
menu. Then select No Color Adjustment.

Windows: Click the ICM button, then select No Color Adjustment.

9. Click OK or click Print to print your photo.

Select your paper

Click Custom

Click Advanced or 
Advanced Settings

Select No Color 
Adjustment
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Printing Borderless Cut Sheets

You can print your photos with no margins, extending the image all the way to the 
edges of the page (not available with Macintosh OS X or when you’re using paper 
types that are compatible with the optional Matte Black ink cartridge).

Note: For instructions on printing borderless photos on roll paper, see page 31.

Although borderless printing is a bit slower, you get beautiful portraits and 
enlargements, without trimming, on these papers and sizes:

Follow the steps for your operating system below to print BorderFree photos on cut 
sheet paper.

Windows

1. Start your printing application and open 
your photo file.

2. Access the printer settings window (see 
page 20). 

3. Select Photo or Best Photo as the 
Quality Type setting.

4. Choose Sheet as the Source setting.

Paper name Sizes Media Type setting

Premium Glossy Photo 
Paper 

Letter, 4 × 6, 5 × 7, 
8 × 10, 11 × 14, 
11 × 17 (B), 
11.7 × 16.5 (A3),
13 × 19

Premium Glossy Photo Paper

Premium Semigloss 
Photo Paper 

Letter, 13 × 19 Premium Semigloss Photo Paper

Premium Luster Photo 
Paper 

Letter, 
11.7 × 16.5 (A3), 
13 × 19

Premium Luster Photo Paper
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5. Select the type of paper you loaded as the Type setting: 

■ Premium Semigloss Photo Paper

■ Premium Luster Photo Paper

■ Premium Glossy Photo Paper

6. Click the Borderless checkbox.

7. Select your paper size as the Size setting.

8. Select Portrait or Landscape as the orientation setting.

9. Click OK.

10. Click OK or Print.

Macintosh

Note: BorderFree printing is not available with Macintosh OS X.

1. Start your printing application and open your photo file.

2. Click File > Page Setup.

3. Select the size of the paper you loaded as the Paper Size setting.

4. Select Auto Sheet Feeder as the Paper Source setting.

5. Click the Borderless checkbox.

6. Select Portrait or Landscape as the orientation setting.
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7. Click OK.

8. Click File > Print.

9. Select the type of paper you loaded as the Media Type setting:

■ Premium Semigloss Photo Paper

■ Premium Luster Photo Paper 

■ Premium Glossy Photo Paper

10. Click Print.

Managing Color with Custom Profiles

Follow the steps in this section to use custom profiles for printing with Adobe 
Photoshop (the instructions cover Photoshop 6.0). You’ll also need to use 
profile-building software to create your profiles, such as Monaco Systems 
MonacoEZcolor or GretagMacbeth® ProfileMaker.™ 

Carefully follow the instructions in these sections for the best results:

■ “Printing a Custom Profile Test Target” below

■ “Creating Your Custom Profile” on page 51

■ “Printing With Your Custom Profile” on page 51

Printing a Custom Profile Test Target

Follow these steps to create individual custom profile test targets for each paper type 
you plan to print on.

Note: The illustrations in this section show Macintosh screens; the Windows 
screens are similar.

1. Start your profile creation software and follow the manufacturer’s instructions to 
open and prepare your test target file. (If you need help, contact the software 
manufacturer for instructions.)

2. When you’re ready to print the test target, select File > Print.
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3. Windows: Click the Properties or Preferences button.

4. Select these settings in the printer settings window:

5. Macintosh: Click Custom, then click the Advanced or Advanced Settings 
button.

Windows: Click the Advanced button.

6. Select these settings in the Advanced window:

7. Macintosh OS 8.6 to 9.x: Click OK to return to the printer settings window.

8. Click OK (Windows) or Print (Macintosh) to print your test target.

9. Repeat these steps to print a test target for each paper type you plan to print on.

Source Space: It doesn’t matter 
which source space you’re using at 
this point

Print Space - Profile: Select 
Same As Source

Type or Media Type: Select the paper 
type for the profile

Color Management: Select No Color 
Adjustment (with Windows, select ICM 
first)

Print Quality: We recommend that you 
select Photo - 1440 dpi, though you can 
select a lower or higher quality setting

High Speed and Edge Smoothing: 
We recommend that you turn off these 
options
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Creating Your Custom Profile

Follow the instructions provided with your profile-building software (such as Monaco 
Systems MonacoEZcolor or GretagMacbeth ProfileMaker) to create your custom 
profile using the test target you printed. Once you create the profile, be sure to place it 
in the correct folder on your computer, as recommended by Microsoft or Apple.® 

Printing With Your Custom Profile

1. Start Photoshop, open your image file, and make sure it is tagged with the 
appropriate source profile. (See your Photoshop documentation for instructions.)

Note: We recommend the ColorMatch RGB source profile for RGB image files.

2. Select File > Print. (With Windows, click the Properties or Preferences button 
on the next screen.)

3. Select these settings in the printer settings window:

4. Click Custom, then click the Advanced or Advanced Settings button. (With 
Windows, just click the Advanced button.)

Source Space: If the photo is tagged 
with a source profile, it is listed as the 
Document option

Print Space - Profile: Select your 
custom printer profile from the 
pull-down menu (such as SP2200 
Premium Luster_PK)

Type or Media Type: Select the type 
of paper for which you created the 
custom profile (in step 6 on page 50).

Print Space - Intent: Select 
Relative Colorimetric
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5. Macintosh 8.6 to 9.x: Select No Color Adjustment.

Macintosh OS X: Select Color Management from the Print Settings pull-down 
menu. Then select No Color Adjustment.

Windows: Click the ICM button, then select No Color Adjustment.

6. Select the same settings on the Advanced window that you selected when you 
printed the test target (in step 6 on page 50). (On Macintosh 8.6 to 9.x, click OK 
to close the Advanced window.)

7. Click OK or Print to print your photo.

Note: The color quality of your prints depend on the quality and accuracy of the 
profiles you choose as the Source Space and Print Space options. Select your 
settings as described above for the most consistent results.
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Maintaining Your Printer

Follow the instructions in this chapter to keep your printer working at its best and to 
prepare it for moving, if necessary: 

■ “Cleaning the Print Head” below

■ “Replacing an Ink Cartridge” on page 55

■ “Swapping the Interchangeable Ink Cartridge” on page 59

■ “Aligning the Print Head” on page 61

■ “Cleaning the Automatic Roll Paper Cutter” on page 64

■ “Cleaning the Printer” on page 64

■ “Transporting the Printer” on page 66

Cleaning the Print Head

If your printouts are unexpectedly light, or dots or lines are missing, you may need 
to clean the print head. This unclogs the nozzles so they can deliver ink properly. 
Print head cleaning uses ink, so clean it only if quality declines. 

This section explains how to clean the print head using the Head Cleaning utility. 

You can also clean the print head by holding down the H ink button on the printer for 
three seconds (when all red H ink lights are off).

Caution: When you don’t turn on your printer for a long time, print quality can 
decline, so turn it on at least once a month to maintain good print quality.
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Running the Head Cleaning Utility

1. Make sure the printer is turned on but not printing, and all the red H ink lights 
are off. (If an H ink light is flashing or on, you need to replace a cartridge; see 
page 55 for details.)

2. Windows: Right-click the  printer icon on your taskbar (in the lower right 
corner of your screen). Select Head Cleaning.

Macintosh OS 8.6 to 9.x: Choose File > Page Setup or Print. Click the 
utility button, then click the  Head Cleaning button.

Macintosh OS X: Open the Applications folder and select EPSON Printer 
Utility. Select SP 2200 in the printer list, click OK, and select Head Cleaning.

3. Follow the instructions on the screen to clean the print head. 

Cleaning takes about 45 seconds, 
during which the printer makes noise 
and the green P power light and 
red H ink lights flash.

4. When the green P power light and red H ink lights stop flashing, make sure paper 
is loaded in the printer and click Print nozzle check pattern. Then click Print. 
The nozzle check pattern prints (see the next section for details).

5. If the nozzle check pattern has no gaps or lines (as shown on page 55), click 
Finish.

If the pattern has white lines, click Clean to clean the print head again. 

If you don’t see any improvement after cleaning three or four times, check the 
solutions beginning on page 74. 

You can also turn the printer off and wait overnight—this allows any dried ink to 
soften—and then try cleaning the print head again. 

Caution: Never turn off the printer 
while the green P power light is 
flashing, unless the printer hasn’t 
moved or made noise for more than 
5 minutes.
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Examining the Nozzle Check Pattern

Examine the nozzle check pattern you printed. Each staggered line should be solid, 
with no gaps, as shown.

■ If your printout looks okay, you’re done. 

■ If you see any gaps (as shown), clean the print head again; see page 54 for 
instructions. 

Replacing an Ink Cartridge

When a red H ink light flashes, the indicated ink cartridge is low on ink. When an 
H ink light stays on, you need to replace the indicated cartridge.

When a cartridge is more than six months old, you may need to replace it if printouts 
don’t look their best. If the quality doesn’t improve after cleaning and aligning the 
print head, you can replace the cartridge even if all the red H ink lights are off.

You can also swap the Photo Black ink cartridge for the optional Matte Black 
cartridge when you print on certain papers. Before and after swapping the cartridges, 
see page 59 for guidelines and additional instructions.

Red ink lights
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Checking the Ink Supply

To check your ink supply, do the following:

■ Windows: Double-click the  icon on the 
Windows taskbar. If a cartridge is low on 
ink, you’ll see a window like this: 

■ Macintosh:
OS 8.6 to 9.x: Choose File > Print, then click 
the  ink icon.

OS X: Choose Applications > EPSON 
Printer Utility > SP2200 > Status Monitor.

You see a window like this:

Click a cartridge image to display information 
about the cartridge.

Purchasing Ink Cartridges

Use these EPSON ink cartridges within six months of installing them and before the 
expiration date on the package:

Caution: To ensure good results, use genuine EPSON ink cartridges and do not 
refill them. Other products may cause damage to your printer not covered by 
EPSON’s warranty.

Ink cartridge Part number

Photo Black (Standard) T0341

Light Black (Gray) T0347

Cyan T0342

Light Cyan T0345

Magenta T0343

Light Magenta T0346

Yellow T0344

Matte Black (optional) T0348
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When you need new ink cartridges, contact your dealer, or call the EPSON Store  at 
(800) 873-7766 or visit www.epsonstore.com (U.S. sales only). In Canada, please call 
(800) 463-7766 for dealer referral. 

Ink Cartridge Precautions

Warning: Keep ink cartridges out of the reach of children.

If ink gets on your hands, wash them thoroughly with soap and water. If ink gets 
in your eyes, flush them thoroughly with water.

Caution: To avoid damaging the printer, never move the print head by hand.

You cannot print if an ink cartridge is empty. Leave the empty cartridge installed 
in the printer until you have obtained a replacement. Otherwise the ink remaining 
in the print head nozzles may dry out.

Removing and Installing Ink Cartridges

Be sure you have a new ink cartridge before you begin. Once you start replacing a 
cartridge, you must complete all the steps in one session. 

1. Make sure the printer is turned on (the green P power light should be on, but not 
flashing). Then open the printer cover.

2. Press the H ink button. 

The print head moves, the green P power 
light flashes, and the H ink light for the low 
or empty cartridge flashes or remains on.

3. Lift up the cartridge cover.

4. Press in the tabs on the ends of the cartridge, 
lift it out of the printer, and dispose of it 
carefully.

SM
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5. Shake the new cartridge four or five times 
before opening its package. (Don’t shake it 
after it’s unpacked.)

6. Remove the new cartridge from its package.
 

7. Slide the new cartridge into its slot. The side 
with the green circuit board goes in the back 
of the slot.

8. Press the cartridge down until it clicks into 
place.

9. If you need to replace any other ink 
cartridges, repeat steps 4 through 8 before 
continuing with step 10.

10. Close the cartridge cover, then close the 
printer cover.

11. Press the H ink button. The printer begins 
charging the ink delivery system.

The green P power light and red H ink 
lights flash and the printer makes noise. 
Charging takes about a minute. When it’s 
finished, the green P power light stops 
flashing and stays on, and the red H ink 
lights go out.

Caution: Never turn off the printer while the green P power light is flashing, 
unless the printer hasn’t moved or made noise for more than 5 minutes.

Cartridge 
cover

Caution: Don’t touch the green circuit 
board on the back of the cartridge; you may 
inhibit normal operation and printing. 

Close cartridge cover and 
printer cover, then . . .

press H ink 
button
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Swapping the Interchangeable Ink 
Cartridge

The Photo Black and optional Matte Black ink cartridges are compatible with 
different paper types and Print Quality settings, as described below. 

* The Matte Black ink cartridge is not compatible with these paper types. You can’t select these as 
the Media Type setting in your printer software.

Note: Select Plain Paper as the Type or Media Type setting to print with Premium 
Bright White Paper using either the Photo Black or Matte Black ink cartridge.

To swap the Photo or Matte Black cartridge:

■ Follow the steps in “Removing and Installing Ink Cartridges” on page 57 to swap 
the cartridge in the far left slot. 

■ Confirm that the new cartridge is selected in your printer software, as described 
on the next page.

Paper type

Photo Black—

Highest compatible 

Print Quality

Matte Black— 

Highest compatible 

Print Quality

Plain paper 720 dpi 720 dpi

Enhanced Matte Paper 2880 dpi 2880 dpi

Premium Semigloss Photo Paper 2880 dpi *

Premium Luster Photo Paper 2880 dpi *

Watercolor Paper - Radiant White 2880 dpi 2880 dpi

Premium Glossy Photo Paper 2880 dpi *

Velvet Fine Art Paper 2880 dpi 2880 dpi
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Confirming the Swapped Cartridge in the Software

Note: Whenever you swap the Photo Black and Matte Black cartridges, follow 
the steps in this section to confirm the swap in your printer software.

Windows

1. Right-click the  printer icon on 
your taskbar (in the lower right 
corner of your screen), select 
Printer Settings, and click the 
Maintenance tab.

2. Select Printer and Option 
Information. You see this 
window:

3. Confirm that the cartridge you 
swapped is selected as the Cartridge 
Option. If not, click your cartridge 
and click OK. (If you can’t click a 
cartridge, it’s already selected.)

You may see a message telling you that your paper Type and/or Quality Type settings 
are not compatible with your cartridge. If so, exit the printer software and restart it, 
selecting compatible settings as listed in the table on page 59.

Macintosh OS 8.6 to 9.x

1. Open the Chooser from the Apple menu.

2. Select SP 2200, then select your USB or 
FireWire port.

3. Close the Chooser.

4. Open an application program and access 
your printer settings (see page 25).

5. Check your available Media Type settings. The settings should match the Media 
Types that are compatible with the swapped cartridge as listed on page 59.

Confirm your 
cartridge is 
selected here
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Macintosh OS X 10.x

1. Open the Print Center and delete the SP 2200 from the printer list.

2. Close the Print Center.

3. Open the Print Center again and add the SP 2200.

4. Open an application program and access your printer settings.

5. Check your available Media Type settings. The settings should match the Media 
Types that are compatible with the swapped cartridge as listed on page 59.

Aligning the Print Head

If your printouts contain misaligned vertical lines, or you see light or dark horizontal 
banding, you may need to align the print head. 

1. Turn on the printer.

2. Load plain, letter-size paper. Also have at least one sheet of Enhanced Matte Paper 
handy for the third alignment pattern.

3. Windows: Right-click the  printer icon on your taskbar (in the lower right 
corner of your screen) and select Print Head Alignment.

Macintosh OS 8.6 to 9.x: Choose File > Page Setup or Print. Click the 
utility button, then click the  Print Head Alignment button.

Macintosh OS X: Open the Applications folder and select EPSON Printer 
Utility. Select SP 2200 in the printer list, click OK, and select Print Head 
Alignment.
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4. Follow the instructions on the screen to 
print a test page. You see this window:

5. On the test page, select the pattern with 
the two vertical lines most precisely 
printed on top of each other. You may 
need to use a magnifying glass or loupe.

Select one pattern each for rows 1 and 2. Then enter the number of the best 
pattern for each row in the corresponding boxes on the screen. Then click Next.

If number 7, 8, or 9 is not the best-aligned pattern, click Realignment to print 
another test page and repeat this step.

6. Follow the instructions on the next screen to print the next test page.

7. On the test page, select the pattern 
with the least noticeable band of 
white or black between the two 
rectangles.

Note: The bands in your test print 
may not be as apparent as the ones in 
this example. This adjustment affects 
only high-speed printing on plain 
paper.

8. If pattern 4 has the least noticeable band, click Next. Then go to step 9.

If another pattern was better, enter that number on the screen, then click 
Realignment to print another test page and repeat steps 7 and 8.

1

2

3

Best pattern in 
this example
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9. You see this window:

Remove the plain paper loaded in the printer 
and load one sheet of Enhanced Matte Paper.

10. Click Print to print the first pattern on the 
next test page.

11. After it prints, remove and reload the test page 
as shown, with pattern row #1 on the right.

12. Click Print again to print the second test 
pattern.

13. Repeat steps 11 and 12 to print the 
third test pattern. You see this screen:

14. On the test page, select the least grainy 
box in each column. 

Select a box for columns 1, 2 and 3. Then enter the number of the best looking 
box in the corresponding boxes on the screen.

15. If box 4 is the least grainy in all the rows, click Finish. If box 4 is the best in one 
or more rows, but you need to realign other rows, clear the checkbox for the rows 
with 4 selected and click Realignment. This prints another test page only for the 
rows left checked; repeat steps 10 through 15 to print and check it.
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Cleaning the Automatic Roll Paper Cutter

If you notice ink smears on the edges of pages cut using the automatic roll paper 
cutter, you need to clean the cutter.

1. Turn on the printer.

2. Make sure roll paper is loaded (see page 12) and the cutter is installed (see 
page 15).

3. Windows: Right-click the  printer icon on your taskbar (in the lower right 
corner of your screen), select Printer Settings, click the Maintenance tab, then 
select Printer and Option Information.

Macintosh OS 8.6 to 9.x: Choose File > Page Setup or Print. Click the 
utility button, then select Printer Option Information.

Note: You can’t use the automatic roll paper cutter when printing with Macintosh 
OS X applications.

4. Click the Cutter Cleaning button. 
You see a screen like this:

5. Click the Clean button.

6. The printer prints on about three 
inches of paper to clean the cutter.

Cleaning the Printer

To keep your printer working at its best, you should clean it several times a year.

Cleaning the Exterior

1. Turn off the printer, unplug the power cord, and disconnect the interface cable.

2. Remove all the paper, then use a soft brush to clean the paper feeders.

3. Clean the exterior of the printer with a soft, damp cloth.
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Cleaning the Interior

1. Turn on the printer. 

2. Load a cleaning sheet (packed with your printer) in the sheet feeder, long edge 
first. 

3. Press the m paper button to feed the sheet. If there is ink on the back of the sheet, 
repeat this step until the paper feeds cleanly. If there’s still ink on the back of the 
sheet after the third try, go to step 4.

4. Dampen the cleaning pad (packed with 
your printer) with water, then squeeze it 
to remove the excess. Clean the black 
plastic area inside your printer as shown:

Warning: Don’t touch the gears or any 
other parts inside the printer.

Caution: Never use a hard or abrasive 
brush, or benzine, alcohol, or thinner for 
cleaning; they can damage the printer 
components and case. 

Don’t get water on the printer components and don’t spray lubricants or oils 
inside the printer.

5. If you still see ink on the back of your printouts, clean the paper rollers. Turn off 
the printer, then load a cleaning sheet in the sheet feeder, long edge first.

6. Dampen the cleaning pad with water, 
then squeeze it to remove the excess.

7. Hold down the H ink button, then press 
and hold the P power button to turn on 
the printer. The printer automatically 
feeds the cleaning sheet, very slowly.

8. While it’s feeding the sheet, open the 
printer cover, reach down into the 
printer, and clean the rotating rollers 
with the cleaning pad as shown.

9. Check the ejected cleaning sheet. If you still see roller marks, load a new sheet and 
repeat steps 5 through 9.

Clean 
here

Cleaning pad
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Transporting the Printer

If you move your printer some distance, you need to remove the ink cartridges and 
prepare it for transportation in its original box or a similar one. Follow these steps:

1. Turn on the printer, then press the H ink button to move the print head into a 
position where you can remove the ink cartridges.

2. Open the printer cover, then open the cartridge cover.

3. To remove all the ink cartridges, press in the tabs on the ends of each cartridge 
and lift each one out of the printer.

4. Set each cartridge down with the label on top 
facing upward. Pack the cartridges separately 
in sealable plastic bags.

5. Close the cartridge cover.

6. Press the H ink button to move the print 
head back to its home position. (The red 
H ink lights come on to indicate that no 
cartridges are installed.)

7. Wait until the print head locks in the far 
right position, then turn off the printer.

8. Unplug the power cord from the electrical outlet. Then disconnect the printer 
cable and power cord from the printer.

9. Remove any paper from the printer, then remove the paper support, roll paper 
holder, basket, and automatic roll paper cutter, if they’re installed.

10. Tape the ink cartridge holder to the printer case 
using packing tape. Then close the printer cover.

Cartridge 
cover

Tape the ink cartridge 
holder to the printer case

Caution: Be sure to remove the tape after 
installing the printer in its new location.
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11. Tape the adjust lever up in the m position with 
packing tape, as shown. Tape it vertically and 
horizontally to hold it up during shipping.

12. Close the output tray and tape it closed vertically.

13. Repack the printer and its attachments in 
the original box using the protective materials 
that came with them.

14. Keep the printer level as you transport it. 

15. After transporting the printer, remove all the tape and replace your ink cartridges, 
as described on page 55. 

16. Test your printer. If you notice a decline in print quality, clean the print head 
(see page 53); if output is misaligned, align the print head (see page 61). 
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Solving Problems

See “Diagnosing Printer Problems” on page 70 to help determine what the cause of 
your printer problem may be. Then see these sections for solutions:

■ “Setup and Software Installation Problems” on page 72

■ “Printer Problems” on page 73

■ “Quality Problems” on page 74

■ “Paper Problems” on page 76

■ “Miscellaneous Problems” on page 77

■ “Uninstalling and Reinstalling Printer Software” on page 78

■ “Where To Get Help” on page 79

Tip: It’s a good idea to check EPSON’s support web site periodically for free 
updates to your printer driver. Visit http://support.epson.com. Download 
instructions are posted for your convenience.

Printer Parts

Paper support and extension

Sheet feeder

Left 
edge 
guide

Control panel

Output tray 
and extensions

Auto cutter connector Adjust lever Interface ports

Manual 
feed 
slot

Roll paper 
holder

Roll paper 
edge guide

(Automatic roll paper cutter 
and basket not pictured)
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Diagnosing Printer Problems

First, check the printer’s lights (see below) or run a printer check (see page 71).

Lights Explanation

Green P power light flashes The printer is receiving a print job, replacing an ink cartridge, 
charging ink, or cleaning the print head.

Green P power light flashes

Red m paper light on

While printing, your paper ran out, multiple sheets fed, or the 
wrong size sheet fed.

■ Sheet Feeder or Manual Feed Slot: If paper is out, load 
more paper and press the m paper button. If multiple 
sheets or the wrong size sheet fed, press the m paper 
button to eject the paper, then turn your printer off and 
then on. For loading instructions, see page 9 (sheet 
feeder) or page 17 (manual feed slot).

■ Roll Paper: See page 12 for instructions on loading or 
reloading roll paper.

Green P power light flashes

Red m paper light flashes

Jammed paper or a foreign object is blocking print head 
movement. Turn off the printer, press the adjust lever down 
to the ! position, and pull out the jammed paper. Open the 
cover and remove any jammed or torn paper, or foreign 
objects. Then do one of the following:

Sheet Feeder: Return the adjust lever to the m position. Turn 
on the printer, reload paper, and press the m paper button. 

Manual Feed Slot: See page 17 for loading instructions.

Roll Paper: Cut off the printed portion with scissors, then 
remove the paper (see page 36) and reload it (see page 12).

Green P power light on 

Red H ink light flashes

The cartridge indicated by the H ink light is low on ink. Make 
sure you have a replacement cartridge, then follow the steps 
on page 57 to install it.

Green P power light on 

Red m paper light flashes

The adjust lever is set incorrectly. Make sure the adjust lever 
is in the correct position for your paper. See page 9 (sheet 
feeder), page 17 (manual feed slot), or page 12 (roll paper).

Green P power light flashes

Red H ink light on or flashing

■ If a red H ink light is on, the indicated cartridge is out of 
ink or not installed. 

■ If a red H ink light is flashing, it is installed in the wrong 
slot or is not compatible with the printer.

Follow the steps on page 57 to install or reinstall the cartridge.
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Running a Printer Check

You can run a printer check to determine whether a problem comes from the printer 
or some other source. 

1. Turn off your printer and computer, then disconnect the printer’s interface cable.

2. Load letter-size paper in the printer.

3. Hold down the m paper button, then press and release the P power button. Hold 
down the m paper button until the P power light flashes.

4. A test page prints showing the printer’s ROM version number and a nozzle check 
pattern. (If the pattern has lines, you need to clean the print head; see page 53.)

■ If the check page prints, the problem probably lies in your software settings, 
interface cable, or computer, or your software may not be installed correctly.

■ If the check page doesn’t print, you may have a problem with your printer.

Try the suggestions in “Problems and Solutions” beginning on page 72. If 
nothing works, contact your dealer or EPSON as described on page 79.

5. Turn off the printer, reconnect the interface cable, then turn on your printer and 
computer.

Green P power light is off or 
flashes

Red m paper light flashes

All red H ink lights are 
flashing or off

The automatic roll paper cutter may have a paper jam or be 
installed incorrectly. 

■ If the P power light is off, the m paper light is flashing, 
and all the red H ink lights are flashing, make sure the 
cutter is installed correctly (see page 15). Press the 
m paper button to clear the error.

■ If the P power and m paper lights are flashing, and the 
red H ink lights are off, the cutter has a paper jam. Turn off 
the printer, remove any jammed paper, and turn the 
printer back on.

If you still see the light pattern, contact your dealer or EPSON; 
see page 79.

Green P power light flashes

Red m paper light and
all red H ink lights flash 
alternately

The printer may have a maintenance request error condition. 
Turn off the printer, wait a few seconds, and turn it on again. If 
the lights are still flashing, contact your dealer or EPSON; see 
page 79.

Lights Explanation
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Problems and Solutions

Setup and Software Installation Problems

The printer makes noise after ink 
cartridge installation.

■ When you install ink cartridges, 
the printer must charge its print 
head for a minute or so. Wait 
until it’s finished (the green 
P power light stops flashing) 
before you turn off the printer, 
or it may use excess ink the next 
time you turn it on. 

■ Make sure the ink cartridges are 
inserted completely and no 
packing material remains in the 
printer. Turn off the printer, 
wait a moment, then turn it 
back on to clear the error.

You’re having problems installing 
or using the printer software.

■ Make sure your printer is turned 
on and its cable is securely 
connected at both ends. Follow 
the installation steps on the 
Start Here sheet, and make sure 
your system meets the 
requirements on page 81.

■ Close other programs, including 
screen savers and virus 
protectors, and install again.

■ If the SP 2200 icon doesn’t 
appear in the Macintosh 
Chooser, you may have too 
many items in the Chooser. 
Delete any unused items.

■ If you see an error message with 
Windows 2000, you may not 
have software installation 
privileges. Contact your System 
Administrator.

■ If you’re using Windows and 
the USB port, make sure your 
system was not upgraded from 
Windows 95; the USB driver 
may not install correctly.

■ Make sure the USB Controller 
is working properly in Device 
Manager. See your Windows 
help system for details.

■ If you’re printing over a 
network, see your on-screen 
Reference Guide for instructions 
on configuring your printer for 
use on a network.

■ In Windows, make sure your 
printer is selected as the default 
printer in the Printers utility. 
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Printer Problems

Only the green P power light is 
on, but nothing prints.

■ Make sure the interface cable is 
securely connected at both ends 
and meets the system 
requirements on page 81.

■ Run a printer check as described 
on page 71. If the test page 
prints, make sure your software 
is installed correctly. 

■ If you’re printing on a network, 
make sure you set up your 
printer for network printing, as 
described in your on-screen 
Reference Guide.

The printer sounds as though it is 
printing, but nothing prints.

■ The print head may need 
cleaning; see page 53 for 
instructions.

■ The printer won’t operate 
properly if it’s tilted or at an 
angle. Place it on a flat, stable 
surface.

Your printer makes noise when 
you turn it on or after it has been 
sitting for awhile.

Your printer is performing routine 
maintenance.

Printing is too slow.

Make sure your system meets the 
requirements listed on page 81. To 
print a high-resolution image, you 
need more than the minimum. You 
may also need to:

■ Clear space on your hard drive 
or run a defragmentation utility.

■ Close open programs that 
you’re not using.

■ Increase your system’s memory 
(RAM).

For the fastest printing:

■ Select Draft (Windows) or set 
the Quality/Speed slider to 
Speed (Macintosh).

■ In the Advanced window, turn 
MicroWeave® off (Macintosh 
only) and turn High Speed on.

■ If your printer is connected to a 
USB hub, disconnect any 
unused USB devices.

■ If you’re using the parallel port, 
enable ECP/DMA mode on 
your computer’s port (see your 
computer documentation).

■ Make sure you didn’t increase 
the ink drying time. Click Help 
or ? on the printer software 
screen for details.
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Quality Problems

You see banding (light lines).

■ Clean the print head; see 
page 53 for instructions. 

■ Select a higher print quality and 
turn off High Speed mode; see 
page 27 (Windows) or page 29 
(Macintosh).

■ Select the correct Type 
(Windows) or Media Type 
(Macintosh) for your paper; see 
page 31.

■ Make sure the printable side of 
the paper is face up; it’s usually 
whiter or shinier.

■ Check the adjust lever. Set it 
to m for most papers. For roll 
paper, see page 12; for thick 
paper, see page 17.

■ The ink cartridges may need 
replacing; see page 55.

■ Align the print head as 
described on page 61.

Your print is blurry or smeared.

■ Make sure your paper isn’t 
damp, curled, or loaded face 
down (load new paper face up). 

■ Use a support sheet with special 
paper, or try loading your paper 
one sheet at a time.

■ Make sure your paper meets the 
specifications listed in the 
on-screen Reference Guide. 

■ Use EPSON papers for proper 
saturation and absorption of 
genuine EPSON inks. 

■ Check the adjust lever. Set it 
to m for most papers. For roll 
paper, see page 12; for thick 
paper, see page 17.

■ Align the print head as 
described on page 61.

■ Clean the automatic roll paper 
cutter (see page 64) and/or the 
paper rollers (see page 64).
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Your printout is faint or has gaps.

■ Clean the print head; see 
page 53 for instructions. 

■ The ink cartridges may be old or 
low on ink; see page 55. 

■ Select the correct Type 
(Windows) or Media Type 
(Macintosh); see page 31.

■ Make sure your paper isn’t 
damaged, old, dirty, or loaded 
face down. For best results, use 
genuine EPSON paper.

Your printout is grainy.

■ Use a higher quality paper or 
select a higher Quality Type 
(Windows; page 27) or Print 
Quality (Macintosh; page 29).

■ Align the print head as 
described on page 61.

■ Increase the image resolution or 
print it in a smaller size; see your 
software documentation.

■ Make sure you’re not printing a 
PostScript® file.

You see wrong or missing colors.

■ Make sure Black Ink Only is off 
(Windows) or Color ink is 
selected (Macintosh), even 
when printing black and white 
photographs.

■ Clean the print head; see 
page 53 for instructions. 

■ The ink cartridges may be old or 
low on ink; see page 55.

■ Try turning off PhotoEnhance.™ 
Also check if you’re using a 
special effect that alters image 
colors, like Sepia.

■ If the contrast looks weak or 
detail is missing from the 
shadows, turn off EPSON 
Natural Color (Macintosh) or 
EPSON Vivid Color 
(Windows).

■ Try changing the Gamma 
setting. See page 27 (Windows) 
or page 29 (Macintosh).

■ Your printed colors can never 
exactly match your on-screen 
colors. However, you can use a 
color management system—
such as ICM (Windows; 
page 27) or ColorSync 

(Macintosh; page 29)—to get as 
close as possible. See page 27 for 
details. Also see the Photoshop 
color management instructions 
on page 49.
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Paper Problems

Paper doesn’t eject fully or is 
wrinkled.

■ If the paper doesn’t eject fully, 
you may have set the wrong 
paper size. Press the m paper 
button to eject the paper, then 
select the correct paper size.

■ If it’s wrinkled when it ejects, 
the paper may be damp or too 
thin. Load new paper.

Paper sheets don’t feed correctly 
or jam in the printer.

■ If paper doesn’t feed or multiple 
pages feed, remove it from the 
sheet feeder. Fan the edges of 
the sheets, reload them against 
the right side of the feeder, and 
slide the left edge guide against 
the paper, but not too tightly. 
Don’t load paper above the 
arrow on the left edge guide.

■ If paper jams, press the m paper 
button. If necessary, open the 
cover and remove any jammed 
or torn pieces. Load new paper 
and press the m paper button.

Thick paper doesn’t feed correctly 
or jams in the printer.

Carefully follow the steps on 
page 17 to use the manual feed slot.

Roll paper doesn’t feed correctly 
or jams in the printer.

■ Cut the end of the paper 
straight across using a triangle or 
other tool. If it’s cut diagonally, 
the paper won’t feed smoothly.

■ If the roll paper end is curled, 
place the end inside a folded 
sheet of paper and roll it 
backwards against the curl.

■ Make sure the paper is loaded in 
the roll paper feeder, not the 
sheet feeder; see page 12.

■ As you load the paper, gently 
hold it in the roll paper feeder 
and press the z roll paper 
button; don’t force the paper in.

■ Select Roll as the Source 
(Windows) or Roll Paper as the 
Paper Source (Macintosh). If 
you select another setting, too 
much paper will feed. (Not 
applicable to Macintosh OS X 
applications.)

■ If extra paper feeds, press the 
z roll paper button for three 
seconds to rewind the paper 
(repeat if necessary to back it all 
the way out). If the m paper 
light is on, press the m paper 
button to turn it off. Reload the 
paper as described on page 12.
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Miscellaneous 
Problems

The image is inverted, as if viewed 
in a mirror.

Turn off Mirror Image (Windows) 
or Flip Horizontal (Macintosh) in 
the printer software, or the mirror 
setting in your program. See 
page 27 (Windows) or page 29 
(Macintosh) for instructions. 

The printer prints blank pages.

■ Make sure your printer is 
selected in the Print window, or 
in the Macintosh Chooser or 
Print Center.

■ Clean the print head; see 
page 53 for instructions. 

You see incorrect characters.

■ Make sure the interface cable is 
securely connected at both ends 
and meets the system 
requirements on page 81. 

■ Make sure your printer is 
selected in the Print window, or 
in the Macintosh Chooser or 
Print Center. 

■ If you’re using a switch box or 
USB hub with your printer, 
connect the printer directly to 
your computer instead.

The margins are incorrect.

■ Make sure the paper settings are 
correct for your paper size. See 
page 20 (Windows), page 25 
(Macintosh OS 8.6 to 9.x), or 
page 27 (Macintosh OS X).

■ Choose the correct margins for 
your paper size. The margins 
must be within the printable 
area of the page; see “Printer 
Specifications” in your 
on-screen Reference Guide.

■ Place your paper against the 
right side of the feeder with the 
left edge guide snug against it. 

■ If you’re using the manual feed 
slot, make sure the paper is 
loaded as described on page 17.

■ Make sure the Borderless 
setting is set correctly for your 
margins; see page 32 for roll 
paper or page 47 for cut sheets.

Too many copies are printing.

Make sure that the Copies option in 
your printer software or program is 
not set for multiple copies.

Image size/position is incorrect.

Make sure the paper and layout 
options are set correctly.



78 Solving Problems

Uninstalling and Reinstalling Printer 
Software

You may need to uninstall and then reinstall your printer driver and utilities if, for 
example, you upgrade your Windows operating system. You don’t need to uninstall 
your other photo software or the EPSON Printer Information Center. 

Windows

1. Click Start, and select Programs or All Programs.

2. Point to Epson or EPSON Printers, then 
select EPSON Printer Software Uninstall.

3. In the next window, select EPSON Stylus 
Photo 2200 and click OK. Then follow the 
on-screen instructions. 

4. Restart your computer, then see the Start Here sheet to reinstall your software.

Macintosh OS 8.6 to 9.x

1. Insert your printer software CD-ROM. 

2. Double-click  EPSON on your desktop, then double-click the  EPSON 
Installer icon in the folder that opens. The Main Menu appears.

3. Click Install Printer Driver. On the 
Installer screen, click the arrow in the 
Easy Install list at the top and select 
Uninstall. Then click the Uninstall 
button at the bottom and follow the 
instructions.

4. Restart your Macintosh, then see the 
Start Here sheet to reinstall your software.
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Macintosh OS X

1. Open the Applications folder, then the Utilities folder.

2. Select Print Center, select SP 2200, and click the Delete button.

3. Restart your Macintosh, then see the Start Here sheet to reinstall your software.

Where To Get Help

If you need help with your printer, Film Factory, or the P.I.M. II Plug-in for Adobe 
Photoshop, see the information below. See page 80 for help with the other software 
that came on your printer CD-ROM. 

EPSON provides technical assistance 24 hours a day through the electronic support 
services and automated telephone services listed below:

To speak to a technical support representative, dial:

■ U.S.: (562) 276-7296, 6 AM to 8 PM, Pacific Time, Monday through Friday and 
7 AM to 4 PM, Saturday. 

■ Canada: (905) 709-2567, 6 AM to 6 PM, Pacific Time, Monday through Friday.

Toll or long distance charges may apply. 

Service Access

World Wide 
Web

From the Internet, you can reach EPSON Support at 
http://support.epson.com. At this site, you can download drivers and 
other files, look at product documentation, access troubleshooting 
information, and receive technical advice through e-mail.

Automated 
Telephone 
Services

A variety of automated help services are available 24 hours a day, seven 
days a week. To use these services, you must have a touch tone 
telephone and call (800) 922-8911. Your EPSON SoundAdvice  
Express Code is 70375. Use this code to quickly select the EPSON 
Stylus Photo 2200 in SoundAdvice. 

SM
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Please have the following information ready:

■ Product name (EPSON Stylus Photo 2200)

■ Product serial number (located on the back of the printer and on its box)

■ Proof of purchase (such as a store receipt) and date of purchase

■ Computer configuration and operating system version

■ Description of the problem

You can purchase ink cartridges, paper, manuals, and accessories from the EPSON 
Store at (800) 873-7766 or visit www.epsonstore.com (U.S. sales only). In Canada, 
please call (800) 463-7766 for dealer referral.

Technical Support for Other Photo Software

For help with the photo software on your CD-ROM, contact these companies:

Software Web site or e-mail Telephone

nik 
multimedia

supportus@nikmultimedia.com (619) 725-3150, 8:30 AM to 5 PM,
Monday to Friday, Pacific Time

Monaco 
Systems

http://monacosys.support.html

support@monacosys.com

(978) 749-9944, extension 2204 or 2213
8:30 AM to 6 PM, Eastern Time, Monday 
to Friday
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Requirements and Notices

Windows System Requirements

To use your printer and its software, we recommend that your system has: 

■ Microsoft Windows compatible PC with a Pentium® II 266 MHz (Windows 98 or Me) or 
350 MHz (Windows 2000 or XP) or better processor (Pentium III 500 MHz recommended)

■ 128MB or more of RAM recommended

■ 200MB or more of free hard disk space recommended

■ VGA or better display adapter and monitor

■ CD-ROM or DVD drive for installing the printer software

■ USB connection: a Windows-compliant USB port and a shielded USB “AB” cable

Parallel connection: a high-speed, bidirectional, IEEE-1284 compliant parallel cable (6 to 10 feet 
long) with a D-SUB, 21-pin, male connector (computer end) and a 36-pin Centronics® 
compatible connector (printer end)

IEEE-1394 connection: an OHCI-compliant IEEE-1394 port or interface card and an 
IEEE-1394 cable

Macintosh System Requirements

To use your printer and its software, we recommend that your system has: 

■ An Apple® iMac™ series, Power Macintosh® G3 or G4, PowerBook,® or iBook™ 

■ Mac OS 8.6 through 9.x, OS X 10.1 or higher (Mac OS 9.0 or later recommended) 

■ 128MB or more of available RAM recommended

■ 200MB or more of free hard disk space recommended

■ VGA display or better

■ CD-ROM or DVD drive for installing the printer software

■ USB connection: a shielded USB “AB” cable

FireWire® connection: an OHCI-compliant FireWire port or interface card and a FireWire cable
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Important Safety Instructions

Before using your printer, read these safety instructions to make sure you use it safely and effectively:

■ Be sure to follow all warnings and instructions marked on the printer.

■ Use only the type of power source indicated on the printer’s label.

■ Connect all equipment to properly grounded power outlets. Avoid using outlets on the same 
circuit as photocopiers or air control systems that regularly switch on and off. 

■ Place the printer near a wall outlet where the plug can be easily unplugged.
Placez l’imprimante près d’une prise de courant où la fiche peut être débranchée facilement.

■ Do not let the power cord become damaged or frayed. 

■ If you use an extension cord with the printer, make sure the total ampere rating of the devices 
plugged into the extension cord does not exceed the cord’s ampere rating. Also, make sure the total 
ampere rating of all devices plugged into the wall outlet does not exceed the outlet’s ampere rating.

■ Keep your printer and computer system away from potential sources of electromagnetic 
interference, such as loudspeakers or cordless telephone base units.

■ Avoid locations that are subject to rapid changes in heat or humidity, shocks or vibrations, or dust.

■ Leave enough room around the printer for sufficient ventilation, leaving at least 3.9 inches 
between the back of the printer and the wall.

■ Do not place the printer near a radiator or heating vent or in direct sunlight.

■ Place the printer on a flat, stable surface that extends beyond the printer base in all directions. The 
printer will not operate properly if it is tilted or at an angle.

■ When transporting or storing the printer, don’t tilt it, stand it on its side, or turn it upside-down. 
This may allow ink to leak from the ink cartridges.

■ Turn off and unplug the printer before cleaning. Clean with a damp cloth only. Do not spill liquid 
on the printer.

Caution: Always turn the printer off using the Ppower button. Don’t switch off the power 
strip or unplug the printer until the green Ppower light is off.

■ Do not block or cover the openings in the printer’s case or insert objects through the slots. 

■ Except as specifically explained in this manual, do not attempt to service the printer yourself. 

■ Unplug the printer and refer servicing to qualified service personnel under the following 
conditions:

If the power cord or plug is damaged; if liquid has entered the printer; if the printer has been 
dropped or the case damaged; if the printer does not operate normally or exhibits a distinct change 
in performance. Adjust only those controls that are covered by the operating instructions.
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Ink Cartridge Safety Instructions

■ Keep ink cartridges out of the reach of children. 

■ Be careful when you handle used ink cartridges; there may be ink remaining around the ink supply 
port. If ink gets on your skin, wash it off with soap and water. If it gets in your eyes, flush them 
immediately with water.

■ Do not put your hand inside the printer or touch a cartridge during printing.

■ Do not move the print head by hand. You may damage the printer.

■ Install the ink cartridge immediately after you remove it from its package. Leaving the cartridge 
unpacked for a long time before use can result in reduced print quality.

■ Do not use an ink cartridge beyond the date printed on the cartridge carton. For best results, use 
up the ink cartridges within six months of first installing them.

■ Store ink cartridges in a cool, dark place.

■ Store ink cartridges with the bottom of the packaging facing down.

■ After bringing an ink cartridge inside from a cold storage site, allow it to warm up at room 
temperature for at least three hours before using it.

■ Shake an ink cartridge 4 or 5 times before removing it from its package.

■ Do not shake an ink cartridge after removing it from its package; this can cause leakage.

■ Do not remove or tear the label on an ink cartridge; this can cause leakage.

■ Do not dismantle the ink cartridges or try to refill them. This could damage the print head.

■ Do not touch the green IC chip on the side of the cartridge. This may affect normal operation and 
printing.

■ If you remove an ink cartridge for later use, protect the ink supply area from dirt and dust and 
store it in the same environment as the printer. Note that there is a valve in the ink supply port, 
making covers or plugs unnecessary, but care is needed to prevent the ink from staining items that 
the cartridge touches. Do not touch the ink cartridge ink supply port or surrounding area.

Automatic Roll Paper Cutter Safety Instructions

■ Turn off the printer before attaching or removing the automatic roll paper cutter.

■ Keep the cutter out of the reach of children.

■ Do not touch the area where the paper ejects.

■ Do not disassemble or modify the cutter.
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FCC Compliance Statement

For United States Users

This equipment has been tested and found to comply with the limits for a Class B digital device, 
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection 
against harmful interference in a residential installation. This equipment generates, uses, and can 
radiate radio frequency energy and, if not installed and used in accordance with the instructions, may 
cause harmful interference to radio or television reception. However, there is no guarantee that 
interference will not occur in a particular installation. If this equipment does cause interference to radio 
and television reception, which can be determined by turning the equipment off and on, the user is 
encouraged to try to correct the interference by one or more of the following measures:

■ Reorient or relocate the receiving antenna.

■ Increase the separation between the equipment and receiver.

■ Connect the equipment into an outlet on a circuit different from that to which the receiver is 
connected.

■ Consult the dealer or an experienced radio/TV technician for help.

WARNING: The connection of a non-shielded equipment interface cable to this equipment will 
invalidate the FCC Certification of this device and may cause interference levels which exceed the 
limits established by the FCC for this equipment. It is the responsibility of the user to obtain and use a 
shielded equipment interface cable with this device. If this equipment has more than one interface 
connector, do not leave cables connected to unused interfaces. Changes or modifications not expressly 
approved by the manufacturer could void the user’s authority to operate the equipment.

For Canadian Users

This Class B digital apparatus complies with Canadian ICES-003.

Cet appareil numérique de la classe B est conforme à la norme NMB-003 du Canada.
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Declaration of Conformity

According to 47CFR, Part 2 and 15 for Class B Personal Computers and Peripherals; and/or 
CPU Boards and Power Supplies used with Class B Personal Computers:

We: EPSON AMERICA, INC. 

Located at: MS: 3-13
3840 Kilroy Airport Way
Long Beach, CA 90806
Telephone: (562) 290-5254 

Declare under sole responsibility that the product identified herein, complies with 47CFR Part 2 and 
15 of the FCC rules as a Class B digital device. Each product marketed is identical to the representative 
unit tested and found to be compliant with the standards. Records maintained continue to reflect the 
equipment being produced can be expected to be within the variation accepted, due to quantity 
production and testing on a statistical basis as required by 47CFR §2.909. Operation is subject to the 
following two conditions: (1) this device may not cause harmful interference, and (2) this device must 
accept any interference received, including interference that may cause undesired operation.

Trade Name: EPSON

Type of Product: Ink Jet Printer

Model: B141A

ENERGY STAR Compliance

As an ENERGY STAR Partner, EPSON has determined that this product 
meets the ENERGY STAR guidelines for energy efficiency. The EPA 
ENERGY STAR office equipment program is a voluntary partnership with 
the computer and office equipment industry to promote the introduction 
of energy-efficient personal computers, monitors, printers, fax machines, 
and copiers in an effort to reduce air pollution caused by power 
generation.
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Epson America, Inc. Limited Warranty

What Is Covered: Epson America, Inc. (“EPSON”) warrants to the first retail purchaser that the 
EPSON printer covered by this limited warranty statement, if purchased and used in the United States 
or Canada, conforms to the manufacturer’s specifications and will be free from defects in workmanship 
and materials for a period of one (1) year from the date of original purchase. EPSON also warrants that 
the consumable ink cartridges enclosed with the printer will perform to the manufacturer’s specified 
usage, which usage may expire before the expiration of the limited warranty for the EPSON printer. 
For warranty service, you must provide proof of the date of original purchase.

What EPSON Will Do To Correct Problems: Should your EPSON printer prove defective during the 
warranty period, please call the EPSON Connection  at (562) 276-7296 (U.S.) or (905) 709-2567 
(Canada) for warranty repair instructions and return authorization. An EPSON service technician will 
provide telephone diagnostic service to determine whether the printer requires service. If service is 
needed, EPSON will, at its option, exchange or repair the printer without charge for parts or labor. If 
EPSON authorizes an exchange for the defective unit, EPSON will ship a replacement printer to you, 
freight prepaid, so long as you use an address in Canada or the U.S. (excluding Puerto Rico and U.S. 
Possessions). Shipments to other locations will be made freight collect. You are responsible for securely 
packaging the defective unit and returning it to EPSON within five (5) working days of receipt of the 
replacement. EPSON requires a debit or a credit card number to secure the cost of the replacement 
printer in the event that you fail to return the defective one. If your printer is being repaired, EPSON 
will direct you to send your printer to EPSON or its authorized service center, where the printer will be 
fixed and sent back to you. You are responsible for packing the printer and for all costs to and from the 
EPSON authorized service center. When warranty service involves the exchange of the printer or a 
part, the item replaced becomes EPSON property. The replacement printer or part may be new or 
refurbished to the EPSON standard of quality, and, at EPSON’s option, may be another model of like 
kind and quality. EPSON’s liability for replacement of the covered printer will not exceed the original 
retail selling price of the covered printer. Exchange products and parts assume the remaining warranty 
period of your original product covered by this limited warranty.

What This Warranty Does Not Cover: This warranty covers only normal use in the United States and 
Canada. This warranty is not transferable and will not apply to products purchased from an end user. 
This warranty does not cover any color change or fading of prints or reimbursement of materials or 
services required for reprinting. This warranty does not cover damage to the EPSON product caused 
by parts or supplies not manufactured, distributed or certified by EPSON. This warranty does not 
cover ribbons, ink cartridges or third party parts, components, or peripheral devices added to the 
EPSON product after its shipment from EPSON, e.g., dealer or user-added boards or components. 
EPSON is not responsible for warranty service should the EPSON label or logo or the rating label or 
serial number be removed or should the product fail to be properly maintained or fail to function 
properly as a result of misuse, abuse, improper installation, neglect, improper shipping, damage caused 
by disasters such as fire, flood, and lightning, improper electrical current, software problems, 
interaction with non-EPSON products, or service other than by an EPSON Authorized Servicer. If a 
claimed defect cannot be identified or reproduced, you will be held responsible for the costs incurred.

SM
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THE WARRANTY AND REMEDY PROVIDED ABOVE ARE EXCLUSIVE AND IN LIEU OF 
ALL OTHER EXPRESS OR IMPLIED WARRANTIES INCLUDING, BUT NOT LIMITED TO, 
THE IMPLIED WARRANTIES OF MERCHANTABILITY, NON-INFRINGEMENT OR 
FITNESS FOR A PARTICULAR PURPOSE. SOME LAWS DO NOT ALLOW THE 
EXCLUSION OF IMPLIED WARRANTIES. IF THESE LAWS APPLY, THEN ALL EXPRESS 
AND IMPLIED WARRANTIES ARE LIMITED TO THE WARRANTY PERIOD IDENTIFIED 
ABOVE. UNLESS STATED HEREIN, ANY STATEMENT OR REPRESENTATIONS MADE 
BY ANY OTHER PERSON OR FIRM ARE VOID. EXCEPT AS PROVIDED IN THIS 
WRITTEN WARRANTY, NEITHER EPSON AMERICA, INC. NOR ITS AFFILIATES SHALL 
BE LIABLE FOR ANY LOSS, INCONVENIENCE, OR DAMAGE, INCLUDING DIRECT, 
SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES, RESULTING FROM THE USE 
OR INABILITY TO USE THE EPSON PRODUCT, WHETHER RESULTING FROM BREACH 
OF WARRANTY OR ANY OTHER LEGAL THEORY.

In Canada, warranties include both warranties and conditions.

Some jurisdictions do not allow limitations on how long an implied warranty lasts, and some 
jurisdictions do not allow the exclusion or limitation of incidental or consequential damages, so the 
above limitations and exclusions may not apply to you. This warranty gives you specific legal rights and 
you may have other rights which vary from jurisdiction to jurisdiction. 

Epson America, Inc. ■  P. O. Box 93012 ■  Long Beach, CA 90809-3012
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Index

A

Adjust lever, 10 to 11, 13, 17 to 18, 70, 74
Adobe Photoshop

managing color with, 49 to 52
P.I.M. plug-in for, 3, 42 to 46

Advanced settings, 27 to 30
Aligning print head, 61 to 63
Automatic mode, Macintosh, 25
Automatic roll paper cutter, see Cutter

B

Background printing, 24, 26
Banding, 74
Basic printing

Macintosh OS 8.6 to 9.x, 25 to 26
Macintosh OS X, 22 to 24
Windows, 20 to 22

Basket
installing, 15 to 16, 31
removing, 37

Best Photo setting, 21, 47
Black Ink Only setting, 11, 75
Blank pages, 77
Blurry images, 74
Borderless setting, 33, 34, 47 to 48
Bright White Paper, 10, 31
Browser, 5
Buttons, 70 to 71

C

Cable, printer, 81
Cancelling printing

Macintosh OS 9.x, 26
Macintosh OS X, 24
Windows, 21

Characters, incorrect, 77
Checking printer, 71
Chooser, Macintosh, 72, 77
Cleaning

cutter, 64
pad, 65
print head, 53 to 55
printer, 64 to 65
sheets, 65

Color management
menu, OS X, 24
settings, 27 to 30, 49 to 52
with custom profiles, 49 to 52

Color problems, 75
ColorSync, 75
Control panel, 69 to 71
Controlling printing

Macintosh OS 9.x, 26
Macintosh OS X, 24
Windows, 21

Custom profiles, 49 to 52
Custom settings, 27 to 30
Cutter

adjusting cutting position, 16, 31
cleaning, 64
installing, 15, 31
problems, solving, 70 to 71, 74
removing, 37
safety instructions, 83
selecting settings for, 33, 34

D

Declaration of Conformity, 85
Default settings, Windows, 22
Documentation, 4 to 6
Draft setting, 21, 73
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E

ECP/DMA mode, 73
Electronic manual, 5 to 6
Energy Star compliance, 85
Enhanced Matte Paper, 10, 31, 61 to 63
Envelopes, 11
EPSON

Film Factory, 3, 38 to 42
help, 79 to 80
Monitor3, 26
Natural Color setting, 75
papers, 10, 31
PhotoCenter, 4
Printer Information Center, 5 to 6
SoundAdvice, 79
Store, 57
Vivid Color setting, 75
warranty, 86 to 87

Exif Print
description, 3
printing with, 38 to 42

F

Faint images, 75
FCC Compliance Statement, 84
Features, 1
Film Factory, 3, 38 to 42
Flip Horizontal setting, 77

G

Gamma setting, 75
Grainy prints, 75

H

Head Cleaning utility, 53 to 55
Help

EPSON, 79 to 80
see also Printer Information Center and 

Troubleshooting
High Speed setting, 73 to 74

I

ICM (Image Color Matching) setting, 46, 52, 
75

Incorrect
characters, 77
colors, 75
margins, 77

Ink cartridge
confirming swapped, 60
level of ink in, 21, 26, 56
Matte Black, optional, 55 to 56, 59 to 60
ordering, 56 to 57
Photo Black, 55 to 56, 59 to 60
problems, solving, 70, 72
removing for transport, 66 to 67
replacing, 55 to 58
safety instructions, 57, 83
swapping interchangeable, 55, 59 to 60

Ink level, checking
Macintosh, 26, 56
Windows, 21, 56

Ink setting
envelopes, 11
problems, solving, 75

Installation problems, 72
Inverted image, 77
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J

Jams, paper, 70, 76

L

Layout problems, 77
Layout settings

Macintosh OS 9.x, 26
Macintosh OS X, 24
Windows, 28

Letterhead, 9
Lever, adjust, 10 to 11, 13, 17 to 18, 70, 74
Lights, 70 to 71
Luster Photo Paper, 10, 31, 32, 35, 47 to 49

M

Macintosh
basic printing, OS 8.6 to 9.x, 25 to 26
basic printing, OS X, 22 to 24
Chooser, 72, 77
custom printing, 29 to 30
system requirements, 81
uninstalling software, 78 to 79

Maintaining printer, 53 to 65
Manual feed slot, 10, 17 to 18, 70, 76
Margins, incorrect, 77
Matte Black ink cartridge, 11, 47, 55 to 56, 59 

to 60
Matte paper, 10, 31, 61 to 63
Media Type setting

envelopes, 11
ink cartridge compatibility, 59
selecting correct, 31
selecting, Macintosh, 23, 25, 35

MicroWeave setting, 73
Mirror images, 77
Monitor3, 26
Monitoring ink level

Macintosh, 26, 56
Windows, 21, 56

Movies, Print Show, 3 to 5
Moving printer, 66 to 67

N

Natural Color setting, EPSON, 75
Network printing, 72
Noise, printer, 73
Nozzle Check, 54 to 55

O

Orientation setting, 11, 21, 22, 25
Output tray

installing, 37
removing, 15

P

P.I.M., see PRINT Image Matching
Page Setup, Macintosh, 22, 25
Paper

EPSON, 10, 31
feeding problems, 76
jams, 70, 76
loading in manual feed slot, 17 to 18
loading in sheet feeder, 9
loading special, 10
roll, see Roll paper
thick, 17 to 18

Paper Size setting, 11, 22, 25, 34
Paper Source setting, 18, 22, 25, 34
Parallel port, 73
Photo Black ink cartridge, 55 to 56, 59 to 60
Photo setting, 21, 47
Photo software, 3 to 4
PhotoCenter, EPSON, 4
PhotoEnhance, 75
Premium Bright White Paper, 10, 31
Premium Glossy Photo Paper, 10, 31, 32, 35, 

47 to 49
Premium Luster Photo Paper, 10, 31, 32, 35, 47 

to 49
Premium Semigloss Photo Paper, 10, 31, 32, 

35, 36, 47 to 49
Preprinted paper, 9
Previewing printout, 26
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Print Center, Macintosh OS X, 24
Print dialog box, Windows, 20, 21
Print head

aligning, 61 to 63
cleaning, 53 to 55

Print Head Alignment utility, 61 to 63
PRINT Image Matching

description, 2 to 3
plug-in for Photoshop, 3, 42 to 46
using with Film Factory, 38 to 42

Print Quality
problems, 74 to 75
setting, 59

Print Settings menu, Macintosh OS X, 23
Print Show movies, 3 to 5
Printer

cable, 81
check, 71
cleaning, 64 to 65
control panel, 69 to 71
maintaining, 53 to 65
noise, 73
parts, 69
problems, 70 to 71, 73
transporting, 66 to 67

Printer and Option Information utility, 16, 60, 
64

Printer Information Center, 5 to 6
Printing

advanced, 27 to 30
controlling, 21, 24, 26
Macintosh, basic OS 8.6 to 9.x, 25 to 26
Macintosh, basic OS X, 22 to 24
Windows, basic, 20 to 22
with custom settings, 27 to 30

Problems
diagnosing, 70 to 71
installing software, 72
miscellaneous, 77
paper feeding, 76
print quality, 74 to 75
printer, 73
solving, 69 to 80

Progress Meter, 21

Q

Quality Type setting, 21
Quality/Speed setting, 23, 25, 73

R

Reference Guide, 5 to 6
Reinstalling software, 78 to 79
Roll paper

basket, see Basket
button, 14, 36
controlling printing, 36
cutter, see Cutter
holder, 12 to 14, 36 to 37
loading, 12 to 14, 31
options, 33, 34
printing on, 31 to 35
problems, solving, 70, 76
removing, 36 to 37
storing, 36 to 37

S

Safety instructions, 82 to 83
Semigloss Photo Paper, 10, 31, 32, 35, 36, 47 to 

49
Service, 79 to 80
Sheet feeder

loading envelopes in, 11
loading paper in, 9
problems, solving, 70, 76

Size setting, 11, 21, 33
Slow printing, 73
Smeared printout, 10, 74
Software

installation problems, solving, 72
photo, 3 to 4
reinstalling, 78 to 79
summary, 3 to 4
uninstalling, 78 to 79

SoundAdvice, 79
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Source setting, 18, 21, 33, 47
Support, 79 to 80
System requirements, 81
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Technical support, 79 to 80
Testing printer, 71
Text & Image setting, 21
Text setting, 21
Thick paper, 17 to 18, 70, 76
Transporting printer, 66 to 67
Troubleshooting, 69 to 80
Type setting

envelopes, 11
ink cartridge compatibility, 59
selecting correct, 31
selecting, Windows, 21, 32
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Uninstalling software, 78 to 79
USB, 72, 77, 81
Utilities

Auto Cutter Adjustment, 16
Cutter Cleaning, 64
Head Cleaning, 53 to 55
Nozzle Check, 54 to 55
Print Head Alignment, 61 to 63
Printer and Option Information, 16, 60, 64

V

Velvet Fine Art Paper, 10, 17 to 18, 31
Vivid Color setting, EPSON, 75

W

Warranty, 86 to 87
Watercolor Paper - Radiant White, 10, 31
Watermark, 26, 28
Windows

basic printing, 20 to 22
custom printing, 27 to 28
default settings, 22
system requirements, 81
uninstalling software, 78
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EPSON Ink Jet Papers and Ink Cartridges

Use EPSON® paper and inks to get the same photo quality results that have earned EPSON’s printers 
all of their awards! EPSON papers are specially coated to work with EPSON UltraChrome™ inks. 
Here are details about just a few of EPSON’s papers, your printer’s ink cartridges, and EPSON project 
ideas:

Enhanced Matte Paper

Enhanced Matte Paper is the perfect choice for photographers requiring a 
heavyweight photo paper without a gloss finish. Results are highly saturated 
images, which maintain excellent highlight and shadow detail.

Premium Luster Photo Paper

This instant drying RC photo paper produces vivid, lifelike images that rival 
those of traditional silver halide prints. Its semigloss “E” surface and 10 mil 
thickness provide a true photographic look and feel.

Velvet Fine Art Paper

With a thick 100% cotton base, this fine art paper offers an elegant, velvet 
finish reminiscent of museum quality prints. Yielding brilliant colors and deep 
blacks, it provides a perfect solution for fine art photography.

Load this paper only in your printer’s manual feed slot, as described in this 
manual.

EPSON Ink Cartridges 

For best results, always use genuine EPSON ink cartridges.

See the inside back cover for a list of cartridges available for your printer.

See the inside back cover for a list of EPSON papers and ink cartridges, and ordering information.



How To Order EPSON Ink and Paper

To order EPSON ink cartridges, paper, and other accessories, contact your dealer or call the EPSON Store at 
(800) 873-7766 or visit www.epsonstore.com (U.S. sales only). In Canada, please call (800) 463-7766 for dealer 
referral.

EPSON Ink Cartridges

EPSON Papers

* Availability of paper types varies by location. See page 31 or your paper instructions to select the Media Type setting.

Ink cartridge Part number Ink cartridge Part number

Photo Black T0341 Magenta T0343

Light Black T0347 Light Magenta T0346

Cyan T0342 Yellow T0344

Light Cyan T0345 Matte Black (optional) T0348

Paper name* Size Part number

EPSON Premium Bright White Paper Letter (8.5 x 11 inches) S041586

EPSON Enhanced Matte Paper Letter (8.5 x 11 inches) S041341

A3 (11.7 x 16.5 inches) S041343

Super B (13 x 19 inches) S041339

EPSON Premium Semigloss Photo Paper Letter (8.5 x 11 inches) S041331

Super B (13 x 19 inches) S041327

4 inches x 26 ft roll paper S041329

EPSON Watercolor Paper - Radiant White Super B (13 x 19 inches) S041351

EPSON Premium Luster Photo Paper Letter (8.5 x 11 inches) S041405 

A3 (11.7 x 16.5 inches) S041406

Super B (13 x 19 inches) S041407

8.3 inches x 32.8 ft roll paper S041408

13 inches x 32.8 ft roll paper S041409

EPSON Premium Glossy Photo Paper Letter (8.5 x 11 inches) S041286

B (11 x 17 inches) S041290

A3 (11.7 x 16.5 inches) S041288

Super B (13 x 19 inches) S041289

4 x 6 inches, Borderless S041682

5 x 7 inches, Borderless S041464

8 x 10 inches, Borderless S041465

11 x 14 inches, Borderless S041466

4 inches x 26 ft roll paper S041302

8.3 inches x 32.8 ft roll paper S041376

13 inches x 32.8 ft roll paper S041378

EPSON Velvet Fine Art Paper Letter (8.5 x 11 inches) S041636

Super B (13 x 19 inches) S041637
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